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     ة طي الفترة الحѧѧѧالیѧѧѧالمنѧѧѧاخیѧѧѧة التي تغ RICCARللحصѧѧѧѧѧѧѧول على بیѧѧѧانѧѧѧات GISات اسѧѧѧѧѧѧѧتخѧѧѧدام أدو

 والمتوقعة للمستقبل

 مقدمة  .1
یھدف ھذا الدلیل التدریبي إلى تعریف المستخدمین بكیفیة تنزیل واستخدام البیانات المناخیة الناتجة عن 

وقابلیة تأثر القطاعات الاجتماعیة موارد المائیة ات المناخیة على اللتقییم أثر التغیر RICCARمبادرة 

لمعلومات الجغرافیة للتعامل مع م نظم امنطقة العربیة، وسѧѧѧیتم التركیز على اسѧѧѧتخداال والاقتصѧѧѧادیة في

  البیانات المناخیة، كما تجدر الإشارة إلى إمكانیة استخدام ھذه البیانات على منصات مختلفة. 

 ریكارغیر المناخي الناتجة عن یانات التملخص عن ب .2
وھي تغطي النطاق العربي الموضѧѧѧѧѧѧѧح في  RICCAR تمثل بیانات التغیر المناخي أحد أھم مخرجات

التقریر العربي ) ، كما تجدر الإشارة إلى أنھا موضحة بشكل تفصیلي في التقریر الرئیسي (1لشكل (ا

 ) .حول تقییم تغیر المناخ

 
  لعربيالنطاق ا) 1الشكل (
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 لى ثلاث فترات: والظواھر المناخیة المتطرفة ع التساقطاتالحرارة و كما تتضمن بیانات معدلات

x  الفترة المرجعیة 
x  قرنصف التفترة من 
x فترة نھایة القرن 

 . RCP8.5وسیناریو الانبعاثات المرتفعة   RCP 4.5من أجل كل من سیناریو الانبعاثات المتوسطة 

 RCMمن نموذج المناخ الإقلیمي  الانحیاز حةانات المصحھذه البیانات فھو البیوأما المصدر الرئیسي ل

 ) . CORDEX( لنموذج المناخي الإقلیميس اقیاالإقلیمیة المنسقة لتقلیص  لتجربةسة من اوالمقتب

(الجدول  2100 – 1951للفترة  )مُسقطة ال(الیومیة المتوقعة  التساقطاتكما تتضمن بیانات الحرارة و

 )، وفق3و  2لیة والسѧѧنویة لنفس الفترة (الجدولین الفصѧѧ متطرفةالظواھر المناخیة الكذلك بیانات ) و1

.  ESM2M-EARTH, and GFDL-CM5, EC-CNRM(1( مدروسةخ عالمیة الشروط المحیطیة لثلاثة نماذج منا

 وھي متوفرة لمختلف السیناریوھات وبدقات مكانیة مختلفة.

 بالصѧѧѧیغة المصѧѧѧححة ما یمكن تنزیلھاعبر الشѧѧѧابكة، ك تى ھذه البیاناكما یمكن لأي شѧѧѧخص الولوج إل

 Regional Knowledge Hub المركز الإقلیمي للمعرفةمن منصѧѧѧѧѧѧѧة  Bias-Corrected الانحیاز

data portal بالإضافة إلى مخرجات  الانحیاز ، أما بیانات النموذج المناخي الإقلیمي الغیر مصححة

الموجودة على  CORDEXھا من بیانات ة الأخرى فیمكن الحصول علیناخیالم تمناخیة خاصة بالنطاقا

 . ESGFموقع 

عن طریقة الوصѧѧѧѧѧѧѧول إلى ھذه  CORDEXوموقع  ESGFمات أكثر تفصѧѧѧѧѧѧѧیلا على موقع معلو تتوفر

 البیانات.

، مع العلم ان البیانات متوفرة راسѧѧѧѧات والأبحاثللد تكما یمكن للمسѧѧѧѧتخدمین الاسѧѧѧѧتفادة من ھذه البیانا

 .Bias corrected الانحیاز ، والثانیة بیانات مصححةRaw dataیغتین: الأولى بیانات أصلیة بص

                                                           
ف 1 یل من تقریر (ت ѧѧѧѧѧѧѧبالتفص ھا  ماذج یمكن الاطلاع علی یل الن ѧѧѧѧѧѧѧق –اص مذجة تطبی یة والن ناخیة الإقلیم مذجة الم ات الن

 المنطقة العربیة_)   يلھیدرولوجیة الإقلیمیة فا
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 وحرارة تساقطاتلمناخیة من ) مخرجات النمذجة الإقلیمیة ا1الجدول (
البارامترات 

 الرمز المناخیة
سیناریو 

 تالانبعاثا
 الغازیة

العالمي  المناخنماذج 
(GCM) ةالدقة المكانی الفترة الزمنیة  

 Pr RCP2.6 EC-EARTH 1951-2100 50 x 50 km تساقطات
 Pr RCP4.5 CNRM-CM5 1951-2100 50 x 50 km تساقطات
 Pr RCP4.5 EC-EARTH 1951-2100 50 x 50 km تساقطات
 Pr RCP4.5 GFDL-ESM2M 1951-2100 50 x 50 km تساقطات
 Pr RCP8.5 EC-EARTH 1951-2100 25 x 25 km تساقطات

تتساقطا  Pr RCP8.5 GFDL-ESM2M 1951-2100 25 x 25 km 
 Pr RCP8.5 CNRM-CM5 1951-2100 50 x 50 km تساقطات
 Pr RCP8.5 EC-EARTH 1951-2100 50 x 50 km تساقطات
 Pr RCP8.5 GFDL-ESM2M 1951-2100 50 x 50 km تساقطات
 Tas RCP2.6 EC-EARTH 1951-2100 50 x 50 km حرارة
 Tas RCP4.5 CNRM-CM5 1951-2100 50 x 50 km حرارة
 Tas RCP4.5 EC-EARTH 1951-2100 50 x 50 km حرارة
 Tas RCP4.5 GFDL-ESM2M 1951-2100 50 x 50 km حرارة
 Tas RCP8.5 EC-EARTH 1951-2100 25 x 25 km حرارة
 Tas RCP8.5 GFDL-ESM2M 1951-2100 25 x 25 km حرارة
 Tas RCP8.5 CNRM-CM5 1951-2100 50 x 50 km حرارة
 Tas RCP8.5 EC-EARTH 1951-2100 50 x 50 km حرارة
 Tas RCP8.5 GFDL-ESM2M 1951-2100 50 x 50 km حرارة

ارة عظمىرح  tasmax RCP2.6 EC-EARTH 1951-2100 50 x 50 km 
 tasmax RCP4.5 CNRM-CM5 1951-2100 50 x 50 km حرارة عظمى
 tasmax RCP4.5 EC-EARTH 1951-2100 50 x 50 km حرارة عظمى
 tasmax RCP4.5 GFDL-ESM2M 1951-2100 50 x 50 km حرارة عظمى
 tasmax RCP8.5 EC-EARTH 1951-2100 25 x 25 km حرارة عظمى
 tasmax RCP8.5 GFDL-ESM2M 1951-2100 25 x 25 km حرارة عظمى
 tasmax RCP8.5 CNRM-CM5 1951-2100 50 x 50 km حرارة عظمى
 tasmax RCP8.5 EC-EARTH 1951-2100 50 x 50 km حرارة عظمى
 tasmax RCP8.5 GFDL-ESM2M 1951-2100 50 x 50 km حرارة عظمى

صغرىرة حرا  tasmin RCP2.6 EC-EARTH 1951-2100 50 x 50 km 
 tasmin RCP4.5 CNRM-CM5 1951-2100 50 x 50 km حرارة صغرى
 tasmin RCP4.5 EC-EARTH 1951-2100 50 x 50 km حرارة صغرى
 tasmin RCP4.5 GFDL-ESM2M 1951-2100 50 x 50 km حرارة صغرى
 tasmin RCP8.5 EC-EARTH 1951-2100 25 x 25 km حرارة صغرى
 tasmin RCP8.5 GFDL-ESM2M 1951-2100 25 x 25 km حرارة صغرى
 tasmin RCP8.5 CNRM-CM5 1951-2100 50 x 50 km حرارة صغرى
 tasmin RCP8.5 EC-EARTH 1951-2100 50 x 50 km حرارة صغرى
 tasmin RCP8.5 GFDL-ESM2M 1951-2100 50 x 50 km حرارة صغرى
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 المتطرفة للحرارة  ظواھر المناخیةالإقلیمیة من ال) مخرجات النمذجة المناخیة 2جدول (لا
Index Long name Climate 

scenario Driving GCM Data period Spatial resolution 

SU Number of summer days RCP4.5 CNRM-CM5 1951-2100 50 x 50 km 
SU Number of summer days RCP4.5 EC-EARTH 1951-2100 50 x 50 km 
SU Number of summer days RCP4.5 GFDL-ESM2M 1951-2100 50 x 50 km 
SU Number of summer days RCP8.5 CNRM-CM5 1951-2100 50 x 50 km 
SU Number of summer days RCP8.5 EC-EARTH 1951-2100 50 x 50 km 
SU Number of summer days RCP8.5 GFDL-ESM2M 1951-2100 50 x 50 km 
SU35 Number of hot days RCP2.6 EC-EARTH 1951-2100 50 x 50 km 
SU35 Number of hot days RCP4.5 CNRM-CM5 1951-2100 50 x 50 km 
SU35 Number of hot days RCP4.5 EC-EARTH 1951-2100 50 x 50 km 
SU35 Number of hot days RCP4.5 GFDL-ESM2M 1951-2100 50 x 50 km 
SU35 Number of hot days RCP8.5 CNRM-CM5 1951-2100 50 x 50 km 
SU35 Number of hot days RCP8.5 EC-EARTH 1951-2100 50 x 50 km 
SU35 Number of hot days RCP8.5 GFDL-ESM2M 1951-2100 50 x 50 km 
SU40 Number of very hot days RCP2.6 EC-EARTH 1951-2100 50 x 50 km 
SU40 Number of very hot days RCP4.5 CNRM-CM5 1951-2100 50 x 50 km 
SU40 Number of very hot days RCP4.5 EC-EARTH 1951-2100 50 x 50 km 
SU40 Number of very hot days RCP4.5 GFDL-ESM2M 1951-2100 50 x 50 km 
SU40 Number of very hot days RCP8.5 CNRM-CM5 1951-2100 50 x 50 km 
SU40 Number of very hot days RCP8.5 EC-EARTH 1951-2100 50 x 50 km 
SU40 Number of very hot days RCP8.5 GFDL-ESM2M 1951-2100 50 x 50 km 
TR Number of tropical nights RCP2.6 EC-EARTH 1951-2100 50 x 50 km 
TR Number of tropical nights RCP4.5 CNRM-CM5 1951-2100 50 x 50 km 
TR Number of tropical nights RCP4.5 EC-EARTH 1951-2100 50 x 50 km 
TR Number of tropical nights RCP4.5 GFDL-ESM2M 1951-2100 50 x 50 km 
TR Number of tropical nights RCP8.5 CNRM-CM5 1951-2100 50 x 50 km 
TR Number of tropical nights RCP8.5 EC-EARTH 1951-2100 50 x 50 km 
TR Number of tropical nights RCP8.5 GFDL-ESM2M 1951-2100 50 x 50 km 
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  تساقطاتالمتطرفة لل ظواھر المناخیةمناخیة الإقلیمیة من ال) مخرجات النمذجة ال3الجدول (
Index Long name Climate 

scenario Driving GCM Data period Spatial 
resolution 

CDD Maximum length of dry spell RCP2.6 EC-EARTH 1951-2100 50 x 50 km 
CDD Maximum length of dry spell RCP4.5 CNRM-CM5 1951-2100 50 x 50 km 
CDD Maximum length of dry spell RCP4.5 EC-EARTH 1951-2100 50 x 50 km 
CDD Maximum length of dry spell RCP4.5 GFDL-ESM2M 1951-2100 50 x 50 km 
CDD Maximum length of dry spell RCP8.5 CNRM-CM5 1951-2100 50 x 50 km 
CDD Maximum length of dry spell RCP8.5 EC-EARTH 1951-2100 50 x 50 km 
CDD Maximum length of dry spell RCP8.5 GFDL-ESM2M 1951-2100 50 x 50 km 
CWD Maximum length of wet spell RCP2.6 EC-EARTH 1951-2100 50 x 50 km 
CWD Maximum length of wet spell RCP4.5 CNRM-CM5 1951-2100 50 x 50 km 
CWD Maximum length of wet spell RCP4.5 EC-EARTH 1951-2100 50 x 50 km 
CWD Maximum length of wet spell RCP4.5 GFDL-ESM2M 1951-2100 50 x 50 km 
CWD Maximum length of wet spell RCP8.5 CNRM-CM5 1951-2100 50 x 50 km 
CWD Maximum length of wet spell RCP8.5 EC-EARTH 1951-2100 50 x 50 km 
CWD Maximum length of wet spell RCP8.5 GFDL-ESM2M 1951-2100 50 x 50 km 
R10 Count of 10 mm precipitation days RCP2.6 EC-EARTH 1951-2100 50 x 50 km 
R10 Count of 10 mm precipitation days RCP4.5 CNRM-CM5 1951-2100 50 x 50 km 
R10 Count of 10 mm precipitation days RCP4.5 EC-EARTH 1951-2100 50 x 50 km 
R10 Count of 10 mm precipitation days RCP4.5 GFDL-ESM2M 1951-2100 50 x 50 km 
R10 Count of 10 mm precipitation days RCP8.5 CNRM-CM5 1951-2100 50 x 50 km 
R10 Count of 10 mm precipitation days RCP8.5 EC-EARTH 1951-2100 50 x 50 km 
R10 Count of 10 mm precipitation days RCP8.5 GFDL-ESM2M 1951-2100 50 x 50 km 
R20 Count of 20 mm precipitation days RCP2.6 EC-EARTH 1951-2100 50 x 50 km 
R20 Count of 20 mm precipitation days RCP4.5 CNRM-CM5 1951-2100 50 x 50 km 
R20 Count of 20 mm precipitation days RCP4.5 EC-EARTH 1951-2100 50 x 50 km 
R20 Count of 20 mm precipitation days RCP4.5 GFDL-ESM2M 1951-2100 50 x 50 km 
R20 Count of 20 mm precipitation days RCP8.5 CNRM-CM5 1951-2100 50 x 50 km 
R20 Count of 20 mm precipitation days RCP8.5 EC-EARTH 1951-2100 50 x 50 km 
R20 Count of 20 mm precipitation days RCP8.5 GFDL-ESM2M 1951-2100 50 x 50 km 
SDII Simple precipitation intensity index RCP2.6 EC-EARTH 1951-2100 50 x 50 km 
SDII Simple precipitation intensity index RCP4.5 CNRM-CM5 1951-2100 50 x 50 km 
SDII Simple precipitation intensity index RCP4.5 EC-EARTH 1951-2100 50 x 50 km 
SDII Simple precipitation intensity index RCP4.5 GFDL-ESM2M 1951-2100 50 x 50 km 
SDII Simple precipitation intensity index RCP8.5 CNRM-CM5 1951-2100 50 x 50 km 
SDII Simple precipitation intensity index RCP8.5 EC-EARTH 1951-2100 50 x 50 km 
SDII Simple precipitation intensity index RCP8.5 GFDL-ESM2M 1951-2100 50 x 50 km 
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 Arcmapفي برنامج ) Multi Dimension Tool(الأداة المتعددة الأبعاد  .3
 

 NetCDFمقدمة إلى صیغة 1.3
من البیانات المناخیة متوفرة بصѧѧѧѧѧیغة RICCARكما ھو الحال مع معظم البیانات المناخیة فإن مخرجات

NetCDF   بة لحفظ قواعد البیانات المتعددة المتحولات حیث یتم تمѧѧѧѧѧѧثیل كل متحول والتي تعتبر مناس

و  Xبالإضافة إلى الإحداثیین یوجد ثلاثة متحولات ھي الزمن RICCARببعد معین، كما في حالة بیانات

Y  كلѧѧارة )2(الشѧѧلفاتأن مإلى . ولابد من الإش NetCDF  أخرى مثل  واجھاتیمكن التعامل معھا من

MATLAB  وPYTHON ةѧѧة البرمجѧѧولغRنتطرقѧѧѧѧѧѧѧدریبي سѧѧل التѧѧدلیѧѧذا الѧѧةإلى  . ولكن في ھѧѧواجھ 

ArcMap GIS  .فقط 

 

 

 

 

 

 

 

 

 NetCDF) المصفوفة البعدیة لملفات 2الشكل (
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 : RICCARالتي تحوي مخرجات  NetCDFأسماء الملفات بصیغة  شرح

 المناخیة بالشكل التالي : RICCARبیاناتالتي تمثل  NetCDF طى ملفاتعت 

pr_MNA-44_CNRM-CERFACS-CNRM-
CM5_historicalandrcp45_r1i1p1_SMHI-RCA4_v1-bc-dbs-
wfdei_day_19510101-21001231_2046_2046.nc 

 حیث :

x Pr :تساقطات(ال المناخي متحولال( 

x MNA-44 النطاق المناخي :CORDEX یة (نطاق قة الوالد العربي والدقة  MENAمكان

 درجة) 0.44المكانیة 

x CNRM-CERFACS-CNRM-CM5  العالمي  المناخ: نموذجGCM 

x historicalandrcp45  4.5: سیناریو الانبعاثات الغازیة (السیناریو( 

x r1i1p1طریقة حساب المتوسط التجریبي : 

x SMHI-RCA4النموذج المناخي الإقلیمي : 

x v1-bc-dbs-wfdei :مدةطریقة التصحیح المعت 

x day (بیانات یومیة) الدقة الزمنیة : 

x 19510101-21001231 دѧѧѧا المجلѧѧѧة التي یغطیھѧѧѧات ا : الفترة الزمنیѧѧѧذي یحوي ملفѧѧѧل

NetCDF 

x 2046_2046  سنة ملف ال :NetCDF  2046بالتحدید (عام( 

(عدد  أیام السنة شریحة تمثل كل یوم من 365یحتوي  NetCDFكما تجدر الإشارة إلى أن كل ملف 

 شریحة). 366شرائح السنة الكبیسة 

: من  DJFوفصلیة ( أ یةسنو NetCDFالمتطرفة، تتوفر ملفات  ظواھر المناخیةبالنسبة لمؤشرات ال
 ،March : من أجل أشѧѧѧѧѧѧѧھر December  ،January ، February – MAMأجل أشѧѧѧѧѧѧѧھر 

April، May- JJAلѧھر  : من أجѧѧѧѧѧѧѧأشJune , ،July ،August – SON ھرѧѧѧѧѧѧѧل أشѧمن أج :
September ،October , ،November حیث كل ملف ،  (NetCDF  ریحة  150یحتويѧѧѧش

 الظواھر المناخیةأما تسѧѧѧمیة الملفات الخاصѧѧѧة بمؤشѧѧѧرات  . )2100-1951سѧѧѧنة ( 150تمثل فترة  
 المتطرفة فتكون على الشكل التالي (على سبیل المثال) :
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su35_MNA-44_ICHEC-EC-EARTH_rcp45_r12i1p1_SMHI-RCA4-
DBS43-WFDEI-1980-2009_v1_day_1951-2100_SON.nc 

 حیث :

x su35 :درجة مئویة) 35جة حرارتھا درالمناخي (عدد أیام السنة التي تتجاوز  متحول 

x MNA-44 النطاق المناخي :CORDEX  یة (نطاق العربي والدقة  MENAوالدقة المكان

 درجة) 0.44المكانیة 

x ICHEC-EC-EARTH العالمي  مناخلا: نموذجGCM  

x historicalandrcp45  4.5: سیناریو الانبعاثات الغازیة (السیناریو( 

x r1i1p1بيری: طریقة حساب المتوسط التج 

x SMHI-RCA4النموذج المناخي الإقلیمي : 

x WFDEI-1980-2009_v1_day التصحیح المعتمدة: طریقة 

x 19510101-21001231  دѧѧѧا المجلѧѧѧة التي یغطیھѧѧѧات : الفترة الزمنیѧѧѧذي یحوي ملفѧѧѧال

NetCDF 

x SON الفصل الذي یمثلھ ملف ال :NetCDF ) September ،October ، November( 
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 : Rasterإلى  NetCDFتحویل ملفات 2.3
 

 :Rasterإنشاء ملف   1.2.3
 ArcMapلا یمكن اسѧѧѧتدعاؤھا وإظھارھا مباشѧѧѧرة إلى واجھة  NetCDFبما أن الملفات بصѧѧѧیغة

تخѧѧѧѧدام  ѧѧѧѧѧѧѧѧاسѧѧѧѧبAdd Data tool ( ، فلا بѧѧѧѧد من مجموعѧѧѧѧة من الإجراءات ضѧѧѧѧѧѧѧѧمن  ( 

Multidimension Tools ) 3الشكل( 

 

 ArcMapي ف Multidimension Tools) قائمة 3الشكل(
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، والسѧѧѧبب )4(الشѧѧѧكل  السѧѧѧواحل من البیانات أحیاناكما یمكن ملاحظة خلو المناطق المتاخمة لخطوط  

على البیانات المناخیة تم اسѧѧѧѧتبعاد كل الخلایا Bias Correctionأنھ خلال إجراء عملیة التصѧѧѧѧحیح 

Cells   انات المناخیة لمثل ھذه البی%. من أجل الحصول على 50التي تغطیھا المیاه بنسبة تزید على

 لى الموقع او إجراء توسیط لقیم الخلایا المحیطة بالموقع.المناطق ینصح باختیار أقرب خلیة إ

 

 

 تبین المناطق الساحلیة بدون بیانات  NetCDF Raster Layerلقطة مكبرة على  )4الشكل(
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  raster شریحةاقتطاع شرائح زمنیة متعددة من 2.2.3
مجموعة من الشѧѧرائح وكل شѧѧریحة تمثل یوم محدد أو سѧѧنة    یحتوي NetCDFل ملف ان كبما 

ائح برمجیة خاصѧѧѧѧة لفصѧѧѧѧل ھذه الشѧѧѧѧر ESRIشѧѧѧѧركة  )، وفرتالمناخي متحولمحددة (بحسѧѧѧѧب 

وبذلك سѧѧѧѧیكون من السѧѧѧѧھل على المسѧѧѧѧتخدمین إجراء عملیات  Raterوتصѧѧѧѧدیرھا بصѧѧѧѧیغ نقطیة

 یѧѧѧѧة مѧѧتѧѧوفѧѧرة عѧѧلѧѧى الѧѧرابѧѧطبѧѧرمѧѧجѧѧالѧѧمѧѧنѧѧѧѧاسѧѧѧѧѧѧѧѧѧبѧѧѧѧة لѧѧھѧѧم ، والensembles ѧѧالѧѧتѧѧوسѧѧѧѧѧѧѧѧѧیѧѧط 

000011318article/-https://support.esri.com/en/technical 

   من خلال واجھةضھا رامن الملف المضغوط، وتظھر عند استع واستخراجھحیث نقوم بتحمیلھا 

ArcCatalog   ) 5 الشكل( 

 

 . ArcCatalogضمن واجھة  NetCDF_time_slice_export) استعراض برمجیة 5الشكل(
 

 Rasterمیة كل ، وبشѧكل تلقائي سѧیتم تسNetCDF ѧویوصѧى باسѧتخدام مجلد مسѧتقل لكل ملف 
 Band-1،على سبیل المثال ) 6(الشكل رقم الفترة الزمنیة یمثل  nحیث Band -n  م ناتجة باس

ث 1تمثل  ثاني ،  2تمثل  Band-2،اني كانون ال كانون الأول  31تمثل  Band-365كانون ال
 بار،ریكار تأخذ السѧѧѧنة الكبیسѧѧѧة بعین الاعتالخاصѧѧѧة ب NetCDF،مع العلم ان ملفات )4 (الجدول

مثل ھذه السѧѧѧѧنة الكبیسѧѧѧѧة یكون  الزمني. وفيإضѧѧѧѧافة یوم إلى الجدول بع سѧѧѧѧنوات ركل أیتم حیث 
Band-366  بة لبارمترات ا ل.الأوكانون  31یمثل یومѧѧالمتطرفة فكل  لظواھر المناخیةأما بالنس

Raster نة واحدة فمثلѧѧناتجة تمثل سBand-1  وال  1951تمثل العامBand-150  یمثل العام
2100  . 

https://support.esri.com/en/technical-article/000011318
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 على أشھر السنة العادیة والكبیسة Bands النطاقاتوزع ت) 4الجدول (

 سنة كبیسة سنة عادیة الشھر
 Band 1 - Band 31 Band 1 - Band 31 كانون الثاني

 Band 32 - Band 59 Band 32 - Band 60 شباط
 Band 60 - Band 90 Band 61 - Band 91 آذار

 Band 91 - Band 120 Band 92 - Band 121 نیسان
 Band 121 - Band 151 Band 122 - Band 152 أیار

 Band 152 - Band 181 Band 153 - Band 182 حزیران
 Band 182 - Band 212 Band 183 - Band 213 تموز

 Band 213 - Band 243 Band 214 - Band 244 آب
 Band 244 - Band 273 Band 245 - Band 274 أیلول

 Band 274 - Band  304 Band 275 - Band  305 لتشرین الأو
 Band 305 - Band 334 Band 306 - Band 335 تشرین الثاني
 Band 335 - Band 365 Band 336 - Band 366 كانون الأول
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 لاقتطاع البیانات المناخیة الخاصة بمنطقة محددة: Model Builderاستخدام  3.2.3
من ملفات  Rastersھي تسریع عملیة تولید عدة طبقات  Model Builderأھم میزة لاستخدام 

NetCDF ام محددة .اھتم متعددة .والتي یمكن فیما بعد اقتطاعھا على منطقة 

  Model Builderنقوم بفتح 

 )6(الشكل  ModelBuilderإلى واجھة  Make NetCDF Raster Layerابدأ بسحب أداة 
 

 Make NetCDF Raster Layer): إضافة أداة 6الشكل (

بتكرار تنفیذ نفس  Model Builder:لیقوم بذلك  Insert  <  Iterators < Filesاختر 
 .)7(الشكل  تعددةالتعلیمة مرات م

 
  Iterate Files): إضافة أداة 7الشكل (
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:لتوجیھ النموذج  Make NetCDF Raster Layerإلى  Fileمن      connectاختر 

model الملف  لاستخدامfile 8(الشكل  كمصدر للبیانات( . 

 

  Make NetCDF Raster Layerأداة و  Fileبین  Connectإضافة ): 8الشكل (
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لإلزام المودیل باختیار ملفات  nc.،ثم أضف  Renameواختر  Fileبالیمین على أیقونة   رقان

NetCDF  9فقط (الشكل ( 

 

  

 للقراءة قطف NetCDF): تحدید ملفات نوع 9الشكل (
 

  )10(الشكل   Insert < Create Variable   Folder>اختر ثم 

 

 تي سیتم العمل علیھا.لا NetCDFمجلد لیحتوي ملفات تحدید ): 10الشكل (

 



16 
 

 Fileمن أجل الاختیار المتكرر من  Iterate Filesو  Folderبین    connectثم اختر 

 )11(الشكل

 

 

 

 

 

 

 .Iterateو تعلیمة NetCDFبین مجلد ملفات  Connectعمل ): 11الشكل (

 

 

 داخلھNetCDF واختر المجلد الخاص الذي تم حفظ ملفات   Folderنقرة مزدوجة على أیقونة 
 .)12(الشكل 

إلى ملونة ما یدل على أن خطوة بناء  model builderعندئذ سѧѧѧѧѧѧѧتتحول الأیقونات في واجھة 
وأیقونة  Make NetCDF Raster Layerة النموذج الحالیة تمت بشѧѧكل صѧѧحیح. بینما أیقون

Output Raster Layer  .تبقى بدون الوان لأنھا لم تكتمل بعد 

 

 . Folderضمن  NetCDFات ر ملفاستحدید م): 12الشكل (
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 ):13(الشكل Make NetCDF Raster Layerنقرة مزدوجة على أیقونة 

x Input NetCDF File  سیكون تلقائیا:File.nc  

x Variableتر : اخpr 

x Output Raster Layer nameیبقى كما ھو : 

x X Dimension :lon 

x Y Dimension : lat 

x Band Dimension   اختر :time  

 

 Make NetCDF Raster Layerإلى نافذة معلومات اللازمة ) إدخال ال13ل (كشال

سوف تتداخل مع تلك في الشكل   NetCDFیدل الشكل البیضوي الأزرق على ان ملفات 

،بكل الأحوال یمكن الاستغناء عن الملف البیضوي الأزرق  .File.ncیضوي الأخضر للملف الب

 .  Deleteبعمل 



18 
 

 Output Rasterو  Make NetCDF Raster Layerكل من  ن(مع الانتباه إلى أ

Layer  سوف تتغیر إلى اللون الأبیض)، والحل ھو نقرة مزدوجة على أیقونةMake 

NetCDF Raster Layer  الصحیحة كما ورد أعلاه،  تكد من الحقول تم ملؤھا بالبیانالتأوا

 ).14(الشكل  Make NetCDF Raster Layerإلى  File.ncمن connectوإعادة  عمل 

 

 في مجلد واحد NetCDF) تكرار العملیة على جمیع ملفات 14الشكل(
 

Run Model.للتأكد من أن كل شيء یسیر على مایرام :  

 : Runنتیجة من اجل استعراض 

من  Clip في بناء ھذا النموذج و ھي إضافة الأداة  الخطوة الأخیرةوھكذا نكون قد وصلنا إلى 

 . NetCDFالتي نتجت من ملفات  Rastersقطیة نلا أجل قص الملفات

 > Tools < Rasterالموجودة في المسار  Clipالأداة   Model Builderأضف إلى واجھة 
Raster Processing . 
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(الشكل البیضوي  Rastersمع ملف مخرجات   Clipللتعلیمة    Connectثم اختر 

 )15الأخضر)(الشكل 

 

 على منطقة محددة. NetCDFالناتجة عن ملفات   Rastrs طیةقن) قص الشرائح ال15الشكل(
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 :  Clipنقرة مزدوجة على أیقونة 

x Output Extent  اختر شریحة :Shapefile الاھتمام التي تمثل منطقة 

x Output Raster Dataset : سیتم حفظ الشرائح المقتطعة ضمنھ،اختر المجلد الذي 

طریقة في التسمیة سوف تسمح بإعطاء ال هھذ) %Name%وأعط للملف الناتج اسما (

 )16(الشكل  NetCDFمتوافقة مع أسماء ملفات  ءالملفات الناتجة أسما

 

 ا

 Clip Raster داةباستخدام الأ إقتطاع الصور ):16لشكل (ا
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) لعرض المخرج بعد Add to display) وأختر ( outputاضغط بالزر الیمین على المُخرج(
 ).17( شكل ھلن عمإنتھاء المودیل م

 
 الصور المُقتطعة إلى الخریطة إضافة ):17شكل (

 

  Runشغلّ المودیل 

 
 NetCDF باند ملف متعددة الباندات، حیث یمثل كلّ  Rasterالمخرج عبارةٌ عن شریحة 

  ).18مقتطع على منطقة الدراسة كما في المثال المعروض لشرق لیبیا ( الشكل و

 

 على منطقة الدراسة الشرائحع قتطاناتج ا): 18شكل (ال
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) الزمنیة الثلاثة الأولى إلى نطاقاتٍ لونیة، ویمكن عرض خصائص تم تقسیم الباندات( النطاقاتی

 ). 19شكل الالمخرج، وإختیار "خصائص" ( rasterمن على طبقة كل نطاق بالنقر بالزر الأی

 

 

 

 

 

 

 

 

 بانداتدة الدعمتال Raster شریحة ): خصائص19شكل (ال

 ).20(شكل  ArcCatalogخصائص كل باند زمني عن طریق  كما یمكن إستعراض

 
 ArcCatalogفي برنامج  الباندات الزمنیةإستعراض  ):20شكل (ال
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 NetCDFمن ملفّ بالبیانات المناخیة الیومیة  ولجد استخلاص 3.3
 

 )nLon,nLatمقدمة إلى مفھوم ( . 1.3.3
شاء lan ،lon( ولرتیة قیاسѧیة تحوي خطوط العرض والطیسѧُتحسѧن العمل ضѧمن أحداثیاتٍ دیكا ) لإن

. أما بالنسѧѧѧѧѧѧѧبة لإنشѧѧѧѧѧѧѧاء بیانات جدولیة من ملفات NetCDFإنطلاقاً من ملف  ،Raster شѧѧѧѧѧѧѧریحة

NetCDFبجب ، ی جداول وھي إالعمل  بال خاصѧѧѧѧѧѧѧѧة  یات  ید nLonو  nLanحداث حد ، حیث یتم ت

لي والتي تبدأ من الزاویة السفلى الیسرى. التواعلى  الشبكة في الصف والعمودلیة خلبرقم االأحداثیات 

 )21الشكل (

 
 الجدولي nLonو  nLanحداثیات ): نظام الشبكة لإ21( الشكل                          

 
عمودا  118 )  وrowسѧѧѧѧѧѧѧطراً ( 232كم)، ھناك  MNA-44 ،50*50بة للنطاق العربي (نسѧѧѧѧѧѧѧالب

)column( ) من الخلایا. أما نطاقMNA-22 ،25*25  یا و  464كم)، فھناك  236سѧѧѧѧѧѧѧطراً أفق

 .( أي الضعف بسبب الدقة المكانیة المضاعفة) عموداً من الخلایا
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باسѧѧѧتخدام  nlatو  nlonالإحداثیات من التقلیدیة إلى اسѧѧѧتنادًا إلى ما سѧѧѧبق، یمكن للمسѧѧѧتخدمین تحویل 

 .MNA-22لـ  4و  3ت لاوالمعاد MNA-44لـ  2و  1المعادلتین 

Nlat =
Lat − (−6.82)

0.44
 (1) 

Nlon =
Lon − (−26.62)

0.44
 (2) 

Nlat =
Lat − (−6.82)

0.22
 (3) 

Nlon =
Lon − (−26.62)

0.22
 (4) 

 

قیم الخلیة ھي أعداد صحیحة  بما أنّ ب قیمة عدد صحیح إلى أقر الناتجة nlatو  nlonقم بتقریب قیم 

 أیضاً.

 NetCDFمن ملفات  لموقع معین الیومیة البیانات المناخیة من لجدو استخلاص .2.3.3
 Multidimension Tools الحزمةالموجودة تحت  Make NetCD Table Viewیمكن لأداة 

 . )22(الشكل  موقعٍ معینعند  NetCDFإنشاء جدول لجمیع القیم من ملف 

 

 Arctoolboxة ذفضمن نا Make NetCDF Table Viewالأداة ): 22( الشكل         
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 اخترالمنѧѧѧاخ المطلوب، و متحولالمنѧѧѧاسѧѧѧѧѧѧѧѧѧب، ثم حѧѧѧدد  NetCDF، حѧѧѧدد ملف عنѧѧѧد فتح الأداة 

 X-Dimensionمن أجل  nlatو  nlon"، ثم اختر row dimensions"من أجل   Timeالوقت

 على التوالي .  . Y-Dimensionو 

 ). 23كل شلالمناسبة للموقع المحدد (ا nlatو  nlonإحداثیات قیم أدخل ثم 

 

 
 Make NetCDF Table View نافذة الأداة  لومات اللازمة ضمنالمع إدخال): 23شكل (ال
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لف زمانیة لمالدقة ال لابد من الانتباه ). 24 الشѧѧѧѧѧѧѧكلسѧѧѧѧѧѧѧیتم تولید جدولٍ للقیم في الموقع المطلوب( 

NetCDF  تخدم في تولیدѧѧѧѧُحیحة لل والتي تسѧѧѧѧات الصѧѧѧѧبیل لعالمناخي المدروس.  متحولالقیاسѧѧѧѧى س

 تسѧѧѧѧѧѧѧاقطاتعبارةٌ عن بیاناتٍ یومیة، لذلك تمثل القیم في الجدول بیانات ال تقطاتسѧѧѧѧѧѧѧایانات الالمثال، ب

تكون على شѧѧكل القیاس ات ت المناخیة الموسѧѧمیة، فوحدمتحولاالیومیة مم/یوم. وكذلك الأمر بالنسѧѧبة لل

 یوم/فصل/سنة.

 

 
                         

 
 

 Make NetCDF Table Viewأداة الناتج عن ة الیومی التساقطاتجدول بیانات  ):24( الشكل
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 :سلسلة زمنیة طویلةبیانات مناخیة ل جدولستخلاص لإ  model builderاستخدام .  3.3.3
مناخي معین في نقطة واحدة  متحولشاء جدول یحتوي على قیم لنلإ Model Builderیمكن استخدام 

 . 2100وحتى  1981 من عام لاً ، مثعلى مدار عدة سنوات

 
متعѧѧددة، بѧѧإسѧѧѧѧѧѧѧتثنѧѧاء الخطوة الأخیرة  rasterتتطѧѧابق الخطوات الأولیѧѧة مع خطوات إقتطѧѧاع طبقѧѧات 

 ).25 الشكل.( Make NetCDF Table Viewالمتمثلة في استخدام أداة 
 

 
 model builderضمن  Make NetCDF Table View): اداة 25( لشكلال

 

 

ینبغي تحویل إحداثیات الموقع إلى  .عمانفي  الیومیة تسѧѧاقطاتبیانات ال إسѧѧتخراج متفي ھذا المثال ، ی
nlon  وnlat. 
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من خلال أخذ المعلومات من أحد ملفات        NetCDF Table Viewأدخل المعلومات في أداة 

NetCDF  )كلفي المجلد ѧѧѧѧѧѧѧوي الأزرق في 26 الشѧѧѧѧѧѧѧمُدخل البیض تذكر أن تحذف ال  .(model 

builder ل لملف ثممالNetCDF بیضوي أخضر اللون (لمُدخل الثم صِل اFile.nc بالأداة. ثم قم (

 . بتشغیل النموذج

 
 modelضمن  Make NetCDF Table Viewداة نافذة الأفي اللازمة  معلوماتإدخال ال ):26( شكلال

builder 
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 نموذجإلى ال Table to Tableأضف أداة 

 الشѧѧѧѧѧѧكل. Conversion Tools>To Geodatabase> Table to Tableمسѧѧѧѧѧѧار الأداة: 

)27.( 

إلى قاعدة بیانات جغرافیة  Make NetCDF Tableسѧѧѧѧѧѧیؤدي ذلك إلى تحویل المُخرج الناتج عن 

)geodatabase.( 

 
 نموذجضمن ال Table to Tableإدخال أداة  ):27شكل (ال

 

ً فوق أیقونѧѧѧѧة  بغي أن یكون عѧѧѧѧدد نیلإدخѧѧѧѧال البیѧѧѧѧانѧѧѧѧات.  Table to Tableانقر نقراً مزدوجѧѧѧѧا

 . Make NetCDF Table View) مساویاً لعدد الصفوف في المخرج الناتج من Rows(الصفوف
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على یحوي  على أنالمُخرج الجدول تسѧѧѧمیة ل دید مجلد المخرجات بالإضѧѧѧافةحت على المسѧѧѧتخدمینبغي 

 ).28 الشكل(لكي یضیف رقماً ممیزاً لكل جدول بدءاً من الرقم  %n%المعلمّة 

 
 

 نموذجضمن ال table to tableإدخال المعلومات في أداة  ):28شكل (ال
 

 : ) 29(الشكل  كالتالي نموذجیصبح شكل ال

 
 نموذج حتى ھذه المرحلةلاشكل  ):29شكل (ال
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 بأكملھ.  نموذجشغلّ ال

كل  ألفتیحیث  لمخرجاتجلد امإنتھاء العملیة إسѧѧѧѧѧѧѧتعراض الملفات الناتجة في  دسѧѧѧѧѧѧѧتخدم بعللم یمكن

 ). dbf.xml، و cpg ،dbfملفات بلواحق ( جدول من ثلاثة

 ).30خ الجدول( الملفاّت الثلاثة) كما في الشكل (قم بنس

 
 إستعراض المخرجات في مجلد الإستخراج ونسخ الجدول الأول ):30( الشكل

 

 كل الجداول في جدولٍ واحد. لدمج  Appendتخدم أداة سن

Data Management Tools>General>Append 
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 .)31كما یظھر في الشكل ( نموذجضمن ال  table to tableعملیة إلى  Append قم بتوصیل

 
 إلى النموذج Appendإضافة الأداة ): 31( الشكل

 

سطة الاتصال سیتم إدخال مجمو ،Appendانقر نقرًا مزدوجًا فوق أداة  عة بیانات الإدخال تلقائیاً بوا
الѧѧѧѧذي تم نسѧѧѧѧѧѧѧخѧѧѧѧھ (أي  dbf). حѧѧѧѧدد ملف precip_%n%.dbf (أي Model Builderفي 

precip_0-Copy.dbf فھ إلى مجموعة البیاناتѧѧѧѧمن مجلد الإخراج المحفوظ على الكمبیوتر وأض (
 ).32الھدف (الشكل 

 
 Appendأداة  اللازمة ضمن نافذة معلومات إدخال ال ):32( الشكل
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 نموذجإلى ال Table to Excelأداة  إضافة 

 Conversion Tools > Excel> Table to Excel المسار من

 ).33 (الشكل ثم قم بتوصیلھا بالمخرج لتحویل صیغ جمیع الملفات إلى ملفات إكسل

 

 
 إلى النموذج Table to Excel داةإضافة الأ):33شكل (ال

 

ً سѧѧѧیكون الجدول المدخل  .Table to Excelنقراً مزدوجاً على اداة انقر  ، نموذجضѧѧѧمن ال إفتراضѧѧѧیا

الخاصة  xls.تحدید مجلد الإخراج وتسѧمیة الملف مع المحافظة على صѧیغة  حتاج المسѧتخدم فقط إلىی

 ).34شكل الاكسل (بملفات 

 
 Table to Excel أداة اللازمة ضمن نافذة المعلومات ): إدخال ال34( شكلال
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یحوي على قیم  بأكملھ ثم قم بتشѧѧغیلھ. سѧѧیكون المخرج عبارة عن جدول بصѧѧیغة اكسѧѧل نموذجاحفظ ال

 ).35شكل ال(  في الموقع المطلوب NetCDFالیومیة( مم/یوم) المأخوذة من كل ملف  تالتساقطا

 
 ملف اكسل الناتج ): إستعراض35شكل (ال
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 Spatial Analystات التحلیل المكاني (إنشاء مجموعاتٍ تحلیلیة بإستخدام أدو .4
tools.( 

 

 حساب التوقعات السنویة والموسمیة  1.4
عام مثلاً) لاسѧѧѧتخلاص أفضѧѧѧل  20زمنیة، كل  ( كمجالاتٍ بیانات المناخیة مجموعات الفضѧѧѧل تحلیل یُ 

ك بنفس التقدیرات المتوقعة من النماذج المناخیة المختلفة، حیث یتم تجمیع نماذج المحاكاة التي تشѧѧѧѧѧѧѧتر

أن یمثل المتوسѧѧѧط  الدقة المكانیة ونفس السѧѧѧیناریو المناخي وإشѧѧѧتقاق المعدل المتوسѧѧѧط منھا، أي ینبغي

 وعة المُختارة. المجم

ختیار ثلاث مجموعاتٍ زمنیة مختلفة، وتم عرض بیانات كل مجموعة ا، تم RICCARفي مشѧѧѧѧѧروع 

 ممثلاً بمتوسطٍ حسابي كالتالي:

x 1986-2005( الفترة المرجعیة( 

x  2046-2065( منتصف القرنفترة( 

x  2081-2100( نھایة القرنفترة( 

على الإنترنت، كما تتوفر  RICCARعلى منصѧѧѧѧѧة  الزمنیة أعلاه متوفرةٌ  المُخرجات في المجموعات

 .2035-2016علیھ المُخرجات الممثلة لفترة مابین 

ة عشѧѧѧѧѧرة دللمسѧѧѧѧѧتخدمین تقییم فتراتٍ مختلفة أخرى غیر المتاحة، مثلاً أن یختاروا فترةً تنبؤیة لم یمكن

تنبؤیة موسѧѧѧمیة، إلا أن ھذه الحالات تتطلب معالجة مجموعاتٍ زمنیة  ضѧѧѧوا بیاناتٍ أو یسѧѧѧتعرسѧѧѧنوات 

 تلائم المطلوب كالتالي:

" إنطلاقاً من ملف Rasterاج ملف "ستخر) في ا3.2.1تتمثل الخطوات الأولى ( مشروحةٌ في القسم 

"NetCDF ُتخراج الفترات الزمنیة من الملف المѧѧѧѧثم اس ،"ѧѧѧѧتخدام أداة "سѧѧѧѧتخرج باسSlice" ) الفقرة

3.2.2.( 

http://www.riccar.org/regional-knowledge-hub
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 Spatial" الموجودة تحت أدوات التحلیل المكاني "Cell Statisticsداة "وبعد ذلك نسѧѧѧѧѧѧѧتخدم الأ

Analyst ندوق الأدوات، حیث یمكننا منѧѧѧѧط وغیره من خلال" في صѧѧѧѧاب المجموع أو المتوسѧѧѧѧھا حس

 )36 لشكلا(  Rasters الشرائحالبیانات الإحصائیة لعددٍ من 

 

 Arctoolboxضمن واجھة  Cell statistics: الأداة ) 36( الشكل
 

. ولكن )37(الشكل  " عادةً لحساب عوامل مناخیة كالحرارةِ مثلاً MEANتُستخدم القیمة الإحصائیة "

، فالتعبیر عن بیانات تسѧѧاقطاتالبیانات الإحصѧѧائیة المتعلقة بال اسѧѧتخراجیما لو أردنا الحسѧѧاب یختلف ف

ثل: مم/شھر أو مم/سنة بدلاً من مم/یوم، لذلك على المستخدم في ھذه الحالة یكون بأشكالٍ م ساقطاتتلا

) ثم یحسѧѧѧѧب Rasterرائح ( المخزنة في شѧѧѧѧ الیومیة لتسѧѧѧѧاقطاتبیانات ا من أجل "SUMأن یختار "

ھلكة للوقت، تسنة ..الخ. قد تكون العملیة مجھدةً ومس -المعدل منھا حسب المدة الزمنیة المطلوبة، شھر

لتسѧѧѧѧریع العملیة  ArcGIS" المتاح في Model Builderلمفید إنشѧѧѧѧاء نموذج باسѧѧѧѧتخدام "لذلك من ا

 وتقلیل الخطأ البشري في تحدید النطاقات ذات الصلة.
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  Cell statisticsداة اللازمة ضمن نافذة الأ المعلوماتأدخال :)37( شكلال

 

المُتحصل علیھا من عدة سنوات، صول على متوسط النتائج ح" للCell Statsticsستخدام أداة "انعید 
 .المعدل المطلوبثم نحسب متوسط النتائج لكل نموذجٍ مناخي لنحصل أخیراً على 

 "raster calculatorبإستخدام اداة "(الإسقاطات) مقارنة التنبؤات  2.4
فترةٍ مرجعیة محددة  تالتنبؤات المسѧѧѧѧѧتقبلیة للعوامل المناخیة مع مخرجا خرجاتمن الشѧѧѧѧѧائع مقارنة مُ 

، RICCARبقة لتبین مقدار التغیر المناخي الذي سیحصل مُستقبلاً. فعلى سبیل المثال، في مشروع سا
وقعѧاً في عوامѧل المنѧاخ أن تغییراً مت 2065-2046بینѧت نتѧائج تحلیѧل فترة أواسѧѧѧѧѧѧѧط القرن الحѧالي 

 ).2005-1986( ند مقارنتھا بالفترة المرجعیةسیحدث، وذلك ع

 " في صѧѧѧѧѧѧѧنѧѧدوق الأدواتRaster Calculatorسѧѧѧѧѧѧѧتخѧѧدام أداة "بѧѧا المتوقع یمكن حسѧѧѧѧѧѧѧѧاب التغیر
Arctoolbox  38(الشكل(: 

 
  Arctoolboxضمن واجھة  Cell statistics: الأداة )38( شكلال
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ریѧѧاضѧѧѧѧѧѧѧیѧѧة كثیرة، وفي حѧѧالتنѧѧا ھѧѧذه، للمقѧѧارنѧѧة، نقوم بطرح القیم التنبؤیѧѧة للفترة  تقوم الأداة بعملیѧѧاتٍ 

 ).39(الشكل  التغیر ساب مقدارلحمُستھدفة من القیم المرجعیة لا

لذلك من  ، ArcMapتیح الأداة إمكانیة إجراء العملیات الحسابیة على الشرائح المتوفرة على واجھة ت

 یمكنناقبل البدء بتشѧѧغیل الأداة. وبذلك  ArcMapإلى واجھة  الضѧѧروري إضѧѧافة الشѧѧرائح المسѧѧتھدفة

سѧѧѧѧѧѧѧتخدام الدالات بالنقر علیھا نقراً مزدوجاً، واابیة علیھا بإضѧѧѧѧѧѧѧافتھا للمعادلة سѧѧѧѧѧѧѧاجراء العملیات الح

 .الطرح)عملیة ھنا فقط  الأداة (نستخدمالریاضیة اللازمة من صندوق الدالات الریاضیة على یمین 

 
  Cell statisticsل المعلومات اللازمة ضمن نافذة الأداة :أدخا) 39( شكلال

 

عبر تقلیص  انیةرفع الدقة المكو)  interpolationالإستقراء المكاني( .5
 ) downscaling(النطاق

 

 ستقراء البیاناتاضبط الدقة المكانیة و 1.5
وجد یكم)، و 25×  25كم مربع( وفي حالاتٍ محدودة  50x50تبلغ الدقة المكانیة للبیانات المناخیة 

 ). Bias-Correction( زتصحیح الانحیافي البیانات في المنطقة الساحلیة بسبب عملیة نقص 

الأخرى. " Rasterبتغییر الدقة المكانیة لكي تلائم ملفات الـѧѧѧѧѧѧѧ" لمستخدم في بعض الأحیاناقد یرغب 

 Resample tool) "Management Tools > Raster > Rasterتتیح أداة "لѧѧѧѧذلѧѧѧѧك 
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Processing ( ٍّتخدم إمكانیة تغییر الدقة المكانیة إلى دقةѧѧѧѧѧكلللمسѧѧѧѧѧالش) الدقة یث إن ح). 40 أخرى

ѧیѧѧѧѧѧѧѧة الإفتراضѧانیѧة ھي المكѧاخیѧنات المن ظام كم، وتظھر بحجم خلی50X50 ѧة للبیѧا ة یعُبرّ عنѧھ في ن

 0.22x0.22كم بـ25x25  ѧѧѧѧѧدرجة. وبالمثل یعُبرّ عن دقة  0.44X0.44حداثیات الجغرافي بـѧѧѧѧѧ الإ

 رجة.د

 

 Arctoolboxضمن واجھة  Resample tool: الأداة ) 40( شكلال
 

( جغرافیة) فإننا مضѧѧطرون لتحویل واحدة القیاس  الدرجة لواحدة المُسѧѧتخدمة في الأداة ھيانظراً لأن 

 "كم" إلى "درجة".
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رقم معادلة كم مثلاً، نسѧѧѧѧѧѧѧتخدم ال 1X1إلى دقةّ  درجة  0.44*0.44لتحویل البیانات المناخیة من دقةّ 

)5 ( : 

𝑥 ∗ 50 = 0.44……………………………(5) 

𝑥 :على بعُدھا بالكیلومتر، حیث تبالدرجا، والتي تقسم بعُد الخلیة  = 1𝑘𝑚 

 ستخدام ھذه المعادلة.اأي دقةٍّ مكانیة ب . یمكننا التحویل إلى 

ضمن باستخدام أربع طرق إحصائیة متاحة " Resampleعملیة "إمكانیة تنفیذ  ArcGISتیح تقنیة ت

  :وھي ArcGISبیئة 

nearest ،majority ،bilinear ،cubic . ثѧѧѧѧانالطریقحیѧѧѧѧةوالأ تѧѧѧѧانیѧѧѧѧلى والث )nearest ،
majorityسب (  للبیانات الفریدة والتي تمتلك حدوداً ممیزة مثل الأبنیة والطرق، أما الأخیرتینتان ) منا
bilinear ،cubic (ل البیانات المناخیة. البیانات المستمرة في رقعةٍ كبیرة مث انتناسبف 

البكسѧѧѧѧѧل الناتج بحسѧѧѧѧѧاب متوسѧѧѧѧѧط  م، بتحدید قیbilinearطریقة باسѧѧѧѧѧتخدام  Resampleتتم عملیة 
بكسѧѧѧѧلاً محیطة  16، یتم احتسѧѧѧѧاب متوسѧѧѧѧط cubicلبكسѧѧѧѧلات الأربعة المحیطة بھ، بینما في طریقة ا

 ).41الشكل ( وإعطاء ھذه القیمة للبكسل الناتج

 ѧѧѧѧѧѧѧѧѧتؤدي عملیة الـResampling لات مѧѧورة ما یجعل إلى تغییر أبعاد البكسѧѧتبدو أكثر للصѧѧتجانس ً . ا

 . یةالأصل للشریحةھو نفسھ  Resampleة عن عملیة الناتجإمتداد البیانات لى أن إوتجدر الإشارة 

 
 Resample toolلومات اللازمة إلى نافذة الأداة عإدخال الم :) 41( الشكل
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توفر لا تانات في الأماكن التي تفتقر إلیھا (كالمناطق الساحلیة التي أما إذا رغب المستخدم باستقراء البی

، فیمكنھ لاعتماد على قیم الخلایا المحیطةبا )  Bias Correctionبیانات مناخیة بسѧѧѧѧبب عملیة ھا یف

 < Spatial Analyst Toolsموجودة على المسѧѧѧѧѧار: ال Interpolationأدوات ذلك باسѧѧѧѧѧتخدام 

Interpolation  ً ، إلا أن Geostatistical Analyst Tools > Interpolation  وأیضѧѧѧѧѧѧѧѧѧا

"، لذلك نسѧѧتخدم Rasterانات بصѧѧیغة "لاتعمل على بی Spatial Analystمتداد لإالأدوات ضѧѧمن ا

  )42(الشكل  Geostatistical Analystوجودة تحت الامتداد الأدوات الم

.  

 

 

 

 

 

 

 

 

 

 .Arctoolboxة ضمن نافذ Interpolationالأداة  :)42( شكلال
 

 تتم ھذه العملیة كالتالي:

 .Geostatistical Analystني بإستخدام أدوات الإمتداد اإجراء الإستقراء المك -1

 .Rasterتحویل المُنتج إلى  -2

 " إلى اللاحقة المرغوبة.Rasterتصدیر " -3
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  Interpolation tool واتأد

كأول خطوة (الشѧѧѧѧѧѧѧكل  ArcGisفي برنامج  Geostatistical l Analystتفعیل إمتداد لابد من 

43.( 

 
 ArcGis برنامج  یل الإمتدادات فيع: كیفیة تف) 43(شكل ال

 

بالضѧѧѧѧѧѧغط بالزر الیمین في الاعلى لتظھر القائمة  Geostatistical toolbarیط أدوات نفعلّ شѧѧѧѧѧѧر

 ).44ونختار الأدوات (الشكل 

 

 . Geostatistical Analyst:  تفعیل شریط الأدوات ) 44(شكل ال
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حیث  )45(شѧѧكل  Geostatistical Wizardأیضѧѧاً باسѧѧتخدام  interpolationیمكن القیام بعملیة 
" التي تعُد أسѧѧرعھا وأكثرھا ملائمةً للبیانات IDWید من طرق الإسѧѧتقراء المتاحة، كطریقة "ھناك العد

من خلال الضѧѧغط  یمكن للمسѧѧتخدم الضѧѧغط على "إنھاء" مباشѧѧرةً أو إسѧѧتعراض الخطوات المسѧѧتمرة.
 خیاراتٍ متقدمة علیھا مثلئج البینیة لتطبیق اسѧѧѧѧѧتعراض النتدم لاعلى "التالي". ( قد یضѧѧѧѧѧطر المسѧѧѧѧѧتخ

 "). Krigingعملیة "

 
 Geostatistical Wizard tool: )45( شكلال

 
 ) والمتضѧѧمنة بیاناتٍ مناخیة46مشѧѧابھة لما ھي علیھ في الشѧѧكل (فسѧѧتكون تطبیق الإسѧѧتقراء  ما نتیجةأ

 مائیة. اطق المسطحات الللنطاق بأكملھ بما فیھا من

 
 IDWطریقة م باستخدا Interpolationعمیلة ثال عن مُخرج م ):46(الشكل 
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سѧѧتعراض ومحمّلة على ذاكرة الحاسѧѧب ولیسѧѧت ى أن ھذه النتیجة( المخرج) ھي للالابد من الإشѧѧارة إل
 محفوظةً علیھ.

" باسѧѧѧتخدام Raster" إلى صѧѧѧیغة "interpolation" راءالاسѧѧѧتقتحویل المنتج عن عملیة ذلك یجب ل
 " GA Layer to Grid أداة "

، ثم Table of Contentsالناتجة في  IDWن على شѧѧѧѧѧѧѧریحة بالزر الیمی اضѧѧѧѧѧѧѧغطلتفعیل الأداة: 
Data>Export>Raster  47(الشكل( 

 

 .Raster: تصدیر الشریحة المؤقتة إلى صیغة )47( الشكل
 

تحدث  كما ھو كي لا ترك اسѧѧѧѧم المخرج الإفتراضѧѧѧѧي فضѧѧѧѧلیُ  GA Layer To Gridضѧѧѧѧمن نافذة 
 المُدخل. بینمالبكسѧѧѧѧل في المخرج نفسѧѧѧѧھ كما في یجب أن یكون حجم ا الأداة. وكذلكثناء عمل أأخطاء 

 .)48(الشكل  دون تعدیل( عدد الأعمدة والصفوف) افتراضیةتبقى باقي القیم 

 
 GA layer to Gridداة نافذة الأ للازمة ضمناإدخال المعلومات : ) 48( شكل
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 نتھاء العملیة.ابعد  Table of Contentsیظھر المُخرج في نافذة كما 

وذلك باسѧѧѧѧتخدام الأداة  على أي منطقة اھتمام،إقتطاع الشѧѧѧѧریحة الناتجة عن العملیة السѧѧѧѧابقة  یمكنكما 

 Spatial Analystالѧѧѧѧѧѧمѧѧѧѧѧѧوجѧѧѧѧѧѧودة فѧѧѧѧѧѧي صѧѧѧѧѧѧѧѧѧѧѧѧنѧѧѧѧѧѧدوق الأدوات عѧѧѧѧѧѧلѧѧѧѧѧѧى الѧѧѧѧѧѧمسѧѧѧѧѧѧѧѧѧѧѧѧار: 

Extract by Maskion>Tools>Extract  49( الشكل.( 

 

 

 

 

 

 

 

 . Arctoolboxضمن نافذة   Extract by Maskختیار الأداة ا:)49( شكلال
 

)، اختر اسѧѧѧѧѧѧѧم ومكان تخزین shapefile or raster( قتطاع علیھاالا منطقة الاھتمام المرادحدد 

 ) الناتجة.rasterالمخرج  (شریحة 

مرغوبة أو تحدث أخطاء عند تسѧѧѧѧѧѧѧمیة المخرج باسѧѧѧѧѧѧѧم آخر غیر  قد یحوي ناتج العملیة بیاناتٍ غیر

ھذه الحالة لحذف البیانات غیر في  Extract by Rectangle لإفتراضѧѧѧѧѧѧѧي، یجب تطبیق الأداةا

 المرغوبة وإعادة تسمیة الملف. 
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 .)50(الشكل  " لھ المواصفات المطلوبة من حیث حجم البكسل والإمتدادRasterالناتج عبارةٌ عن "

 Extract by Maskداة لأضمن نافذة اإدخال المعلومات اللازمة : ) 50( شكلال

) Raster شѧѧѧѧѧریحة)، اختر المدخل (Shapefile or Raster( علیھحدد الشѧѧѧѧѧكل المراد الإقتطاع 

 الناتجة.

قد یحوي ناتج العملیة بیاناتٍ غیر مرغوبة أو تحدث أخطاء عند تسѧѧѧѧѧѧѧمیة المخرج باسѧѧѧѧѧѧѧم آخر غیر 

البیانات غیر  ففي ھذه الحالة لحذ Extract by Rectangle تطبیق الأداة الإفتراضѧѧѧѧѧѧѧي، یجب

 . المرغوبة وإعادة تسمیة الملف

 " لھ المواصفات المطلوبة من حیث حجم البكسل والإمتداد.Rasterعبارةٌ عن "الناتج 

 ):downscaling(أي تقلیص النطاق قدمة إلى زیادة قدرة التمییز المكاني م 2.5
ھ على المسѧѧѧѧتوى الإقلیمي. ملاسѧѧѧѧتخدا RICCAR الخاص ب المناخي الإقلیمي وذجطویر النمتم تلقد 

مناسبة للدراسات على نطاق أصغر، مثل مستوى الحوض، حیث یمیل كانیة الدقةّ المقد لا تكون لذلك ف

" واسѧѧѧѧتقراء Resamplingالمسѧѧѧѧتخدم في مثل ھذه الحالات لرفع الدقة المكانیة للبیانات باسѧѧѧѧتخدام "

 ). 1.5لبیانات كما ھو موضحٌ في القسم (ا
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-Coاو " "Kriging"، مثل "interpolationدم لتطبیق أسѧѧѧѧѧѧѧالیب أخرى لعمل "خوقد یلجأ المسѧѧѧѧѧѧѧت

Kriging" ث أن أداةѧѧة، حیѧѧة غیر مقبولѧѧذه الطریقѧѧات، إلا أن ھѧѧانѧѧة البیѧѧادة موثوقیѧѧلزی "Kriging "

 Venäläinen andالتاریخیة. راجع تسѧѧѧѧѧѧѧُتخدم لإسѧѧѧѧѧѧѧتقراء بیاناتٍ مثل بیانات الأرصѧѧѧѧѧѧѧاد الجویة 

Heikinheimo (2002)) ،Jeffrey et al. (2001 ،Spadavecchia and Williams 

 ، وآخرین.(2009)

لتحویل مخرجات النمذجة المناخیة بشѧѧѧѧѧѧѧكل صѧѧѧѧѧѧѧحیح إلى نطاق مكاني أو زمني أصѧѧѧѧѧѧѧغر، یجب على 

)، وتشѧѧѧѧѧѧѧمل ھذه Downscaling(تقلیص النطاق المسѧѧѧѧѧѧѧتخدمین إجراء عملیة رفع الدقة المكانیة أو 

 ینامیكیة وإحصائیة. دالعملیة على مقاربتین رئیسیتین: 

على دفع النموذج المناخي للعمل على نطاق فرعي أصѧѧѧѧѧѧѧغر نطاق للینامیكي الدقلیص تالیعمل منھج 

)Sub-domain من النطاق الأكبر باستخدام بیاناتٍ مُراقبة أو المخرجات الأخرى للنموذج المناخي (

 ي. كشرطٍ حدّ 

 عقدّة جداً أنھا مُ  ئیة لتولید البیانات المناخیة، إلااعلى الرغم من أن ھذه الطریقة تعتمد على أسѧѧѧѧѧѧѧسٍ فیزی

 وتستلزم عملیاتٍ حسابیة كثیفة.

ت متحولابالنسѧѧبة للمقاربة الإحصѧѧائیة: فھي تأخذ بعین الإعتبار العلاقات الإحصѧѧائیة( المقارنات) بین 

عتبار بجانب ، مثل أخذ قیم الضѧѧѧѧغط الجوي بعین الإةقلیمیالإثلاً وتلك المناخ على المسѧѧѧѧتوى المحلي م

ت النمѧѧѧذجѧѧѧة. لمزیѧѧѧد من المعلومѧѧѧات ، راجع على مُخرجѧѧѧاحصѧѧѧѧѧѧѧѧѧѧائیѧѧѧة تطبیق ھѧѧѧذه العلاقѧѧѧات الإ

Teutschbein and Seibert (2010)  .وغیرھما 

 أدوات إضافیة لتحلیل البیانات المناخیة .6
أخرى للقیام بدراسѧѧѧѧѧѧѧة حالاتٍ وأبحاث أخرى، مثل حسѧѧѧѧѧѧѧاب مكن للمسѧѧѧѧѧѧѧتخدمین إیجاد أدواتٍ مفیدةٍ ی

ѧѧѧѧانات والجفاف. ھذه الأدوات تارة أو التواقع مُخالمتطرفة في م ظواھر المناخیةات الرمؤشѧѧѧѧنبؤ بالفیض

 .RICCARواستخدامھا مشروح في دلیل مشروع 
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 Rasterإلى  NetCDFتحویل ملفات حول الأول العملي التمرین 
 

بحسѧѧب  1980م االیومیة للع تسѧѧاقطاتالخاصѧѧة بقیم ال) Rasters( شѧѧرائحالسѧѧتنتاج ا المطلوب :
انطلاقا من   rcp 4.5لانبعاثات المتوسѧѧѧѧѧѧѧطة لسѧѧѧѧѧѧѧیناریو ا CNRM-CM5العالمي  المناخنموذج 
 .NetCDFملفات 

ضѧѧѧمن المجلد"  NetCDFبصѧѧѧیغة  متوفرة  1980یومیة لسѧѧѧنة  تسѧѧѧاقطاتبیانات البیانات المتاحة: 

pr-CNRM-CM5_rcp45_50km". 

 ArcMapسѧѧѧѧѧتدعاؤھا وإظھارھا مباشѧѧѧѧѧرة إلى واجھة الا یمكن  NetCDF بما أن الملفات بصѧѧѧѧѧیغة

) Add Data toolباستخدام  Multidimension، فلا بد من مجموعة من الإجراءات ضمن  ( 

Tools  لتحویلھا إلى صیغةRaster. 
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   Make NetCDF Raster Layerاختر  Multidimension Toolsمن القائمة 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 .Arctoolboxضمن نافذة  Make NetCDF Raster Layer) الأداة 1.1الشكل (
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 نتبع الخطوات التالیة: Make NetCDF Raster Layerنافذة ضمن 

من مجلѧѧد  1980الخѧѧاص بѧѧالعѧѧام  NetCDFنختѧѧار ملف  : Input NetCDF fileمن أجѧѧل  -1

 الیومیة. تساقطاتال

 

 Make NetCDF Raster  ضمن نافذة  1980الیومیة الخاصة بسنة  تساقطاتملف ال ختیارا) 2.1الشكل (
Layer  

 

 pr وھومن القائمة المنسدلة المتحول المناخي المطلوب نختار  : Variableمن أجل  -2

 

  Make NetCDF Raster Layerالمناخي ضمن نافذة    متحولتحدید ال) 3.1الشكل (
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 lon نختار من القائمة المنسدلة:  X Dimensionمن أجل  -3

 

  Make NetCDF Raster Layerضمن نافذة     x) تحدید البعد 4.1( الشكل
 

 lat من القائمة المنسدلة :نختار Y Dimension من أجل -4

 

  Make NetCDF Raster Layerضمن نافذة    y) تحدید البعد 5.1الشكل (
 

سѧѧѧѧѧوف یسѧѧѧѧѧمح بعرض الملف ضѧѧѧѧѧمن نظام الإحداثیات   y=latو   x= lon ملاحظة : اختیار
 یة ...الخ)دن أو الحدود الدولغرافي  بما یتلاءم مع باقي الشرائح مثل المجال

ضѧѧѧѧѧѧمن  ArcMapفسѧѧѧѧѧѧوف یعرض الملف على واجھة  y=nlatو  x=nlonبینما لو اخترنا 
 )21الشكل (RICCARبیاناتنظام الإحداثیات الخاص ب
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 نترك اسم الشریحة الناتجة بدون تغییر:    Output Raster Layerمن أجل -5

 Okننقر  -6

 

  Make NetCDF Raster Layer) نافذة  6.1الشكل (
 

والذي  NetCDFستمثل أول فترة زمنیة ضمن ملف ال  ArcMapلشریحة الناتجة على واجھة ا
 حرارة وال تساقطاتكانون الثاني بالنسبة لبارامترات ال 1سیكون عادة أول یوم في السنة 

 

  1/1/1980الیومیة للیوم  التساقطاتجة وھي شریحة ت) الشریحة النا7.1الشكل (
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 ام السنة:أیمن أجل استعراض باقي 

 في قائمة المحتویات،  raster layer fileبالنقر بالیمین على  Layer Propertiesاختر  .1

  NetCDFثم اختر قائمة  .2

ات الزمنیѧѧѧة التي یتضѧѧѧѧѧѧѧمنھѧѧѧا ملف یمكن اسѧѧѧѧѧѧѧتعراض كѧѧѧل الفترDimension Valuesمن  .3

NetCDF  محدد.  یوم، ویمكن للمستخدم اختیار 

 

 

 

 1980یومیة المختلفة خلال العام ) استعراض الشرائح ال8.1الشكل (
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 ستعراض الفترات الزمنیة المختلفة ضمن الشریحة الناتجة:ا

 Dimensionلمنسدلة  ،وبفتح القائمة ا NetCDFوتحت الأیقونة   Layer propertiesمن نافذة 

Values ریحة الناتجة تحوي  ننجد أѧѧѧѧریحة تمثل القی 365الشѧѧѧѧاقطاتم الیومیة شѧѧѧѧ1980للعام  للتس 

 ،وفیما یلي بعض الأمثلة عن ھذه الشرائح. 31/12/1980ونھایة ب  1/1/1980ابتداء من 

  13/1/1980سنختار من القائمة المنسدلة الیوم  .1

 Okثم ننقر  .2

 

 

  اصة بھخلاستعراض الشریحة الار یوم محدد اختی) 9.1الشكل (
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 ArcMapعلى شاشة  13/1/1980للیوم  طاتالتساقوستظھر الشریحة التي تمثل 

 

 

  13/1/1980الیومیة للتاریخ   التساقطات) شریحة 10.1الشكل (
 

 ، 11/8/1980،  26/5/1980وبنفس الطریقة نختار الأیام 

  26/5/1980لتاریخ  یة الیوم التساقطات) شریحة 11.1الشكل (
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  11/8/1980الیومیة لتاریخ   التساقطات) شریحة 12.1(الشكل 
 

ن الشѧѧѧѧѧѧریحة النقطیة التي تظھر على الشѧѧѧѧѧѧاشѧѧѧѧѧѧة محفوظة إلى ذاكرة الكومبیوتر لابد من الانتباه إلى أ

  :حفظھا بشكل دائم لذلك ومن أجل بصورة مؤقتة ،

تاریخ ولیك raster layer file انقر بالیمین على  .1 حتویات ، ثم مفي قائمة ال 11/8/1980ن لل

  Export Dataاختر

2. Locationری: اخѧѧѧѧѧѧѧیتم تخزین الشѧѧѧѧѧѧѧمن المجلد  حة الناتجة داخلھتر المجلد الذي سѧѧѧѧѧѧѧولیكن ض ،

NetCDFtoRaster 

3. Name  شریحة الناتجة ولیكن سم لل بحیث یعبر الاسم عن التاریخ  pr_11_8_1980: نعطي ا

 ثلھ الشریحة.الذي تم

4. Format نختار الصیغة :Tiff 

 Saveانقر  .5
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 .  Rasterالمؤقتة الناتجة إلى صیغة  ) تصدیر الشریحة13.1الشكل (
 

 الحالیة. ArcMapلإضافة الشریحة الناتجة إلى واجھة  yesنختار  Output Rasterفي نافذة 

 

 

 

 

 ArcMapالناتجة إلى واجھة  Raster) إضافة 14.1الشكل (
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ة من ملفات سلسلة زمنیة یومیة لسنة معیناستخلاص حول ي نالثاعملي التمرین ال
NetCDF 

 

العالمي  المناخبحسѧѧѧѧѧب نموذج  2046للعام المتوقعة  الیومیة التسѧѧѧѧѧاقطاتقیم نتاج المطلوب :اسѧѧѧѧѧت
CNRM-CM5  لسیناریو الانبعاثات المتوسطةrcp 4.5    لمحطة الصویري في العراق. 

 نات المتاحة:البیا

 Long = 44.770541˚E     Lat= 33.25148˚Nیات المحطة ثإجدا .1

-pr-CNRMالѧѧمѧѧجѧѧلѧѧѧѧد ة ضѧѧѧѧѧѧѧѧمѧѧن مѧѧوجѧѧود 2046یѧѧومѧѧیѧѧѧѧة لѧѧلѧѧعѧѧѧѧام  تسѧѧѧѧѧѧѧѧѧѧاقѧѧطѧѧѧѧاتمѧѧلѧѧفѧѧѧѧات  .2

CM5_rcp45_50km”  " 

مجھز بالمعادلات اللازمة للتحویل بین نظام  (Convert to nlat nlon )باسѧѧѧѧم  Excelملف  .3

 .يالجدول RICCARیات الإحداثیات الجغرافي و نظام إحداث
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بدایة لابد من ت الدیكارتي  nlon, nlat المحطة من النظام الجغرافي إلى نظامإحداثیات  لیوحفي ال

 :المجھز بالمعادلات اللازمة  (Convert to nlat nlon )باستخدام ملف الإكسل 

 

 
 كسل لإ) إدخال الإحداثیات الجغرافیة لمحطة الصویري إلى ملف ا1.2الشكل (

 

 والنتیجة ستكون كمایلي:

Nlon= 162  

 Nlat= 91 
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خدم الأ  Multidimensionدوات الموجودة تحت أ Make NetCD Table Viewداة نسѧѧѧѧѧѧѧت

Tools  اء جدولѧѧѧة منلإنشѧѧѧتخلصѧѧѧملف  یحتوي البیانات المناخیة الیومیة المسNetCDF  ٍعند موقع

 معین. 

 

 .Arctoolboxضمن نافذة  Make NetCDF Table View) الأداة 2.2الشكل (
 

 نختار: Make NetCDF Table Viewن نافذة م

من  2046الخاص بالعام  NetCDF ملفنختار :  Input netCDF Table Viewمن أجل  .1
 الیومیة. لتساقطاتملف ا

 

 Make NetCDF Tablrضمن نافذة    2046الیومیة الخاصة بسنة  التساقطات) اختیار ملف 3.2الشكل (
View 



61 
 

 
  Prمن القائمة المنسدلة وھو  متحولدد النح:  Variablesن أجل م .2

 

  Make NetCDF Table Viewة   المناخي ضمن نافذ متحول) اختیار ال4.2الشكل (
 

 Timeنختار من القائمة المنسدلة  : Row Dimensionsمن أجل  .3

 

 Make NetCDF Table Viewنافذة    المناخي ضمن متحول) اختیار ال5.2الشكل (
 

 . nlat  ثم  nlon أولا: نختار  Dimension values    من اجل .4

 

 Make NetCDF Table Viewة   ضمن نافذ yو x) اختیار البعدین 6.2الشكل (
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  Nlat =91و  Nlon  =162اثیات الموقع :دندخل قیم إج:  Valueمن أجل  .5

 

 Make NetCDF Table Viewالموقع ضمن نافذة    ت) إدخال إحداثیا2.7الشكل (
 

 okننقر  .6

 

 Make NetCDF Table View)  نافذة   8.2لشكل (ا
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 واحدتھا مم/الیوم 2046الیومیة للعام  قطاتالتساالنتیجة وھي جدول یبین استعراض  1`

 

-pr_MNA-44_CNRM-CERFACS“باسم ArcMapیظھر الجدول في قائمة المحتویات في 

CNRM-1”ار ت، من أجل استعراضھ ننقر بالیمین ونخOpen 

 

 

 الناتج. الیومیة تساقطات) استعراض جدول بیانات ال9.2الشكل (
 

والتي تسѧѧѧُتخدم في   NetCDFلاحظ الدقة الزمنیة لملف  المطلوبسѧѧѧیتم تولید جدولٍ للقیم في الموقع 

عبارةٌ عن  التساقطاتیل المثال، بیانات بالمناخي المدروس. على س متحولتولید القیاسات الصحیحة لل

الیومیة مم/یوم. وكذلك الأمر بالنسѧѧѧѧѧѧѧبة  تسѧѧѧѧѧѧѧاقطاتناتٍ یومیة، لذلك تمثل القیم في الجدول بیانات البیا

 موسمیة، فوحدات القیاس تكون على شكل یوم/فصل/سنة.ناخیة الت الممتحولالل
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یومیة لسنوات متعددة من ملفات  ةاستخلاص سلسلة زمنیالتمرین الثالث حول 
NetCDF خدام باستModel Builder  

العالمي  المناخبحسب نموذج  2100 - 1951الیومیة  للفترة  التساقطاتاستخلاص قیم  المطلوب :
CNRM-CM5 یناѧѧѧѧطة لسѧѧѧѧریو الانبعاثات المتوسrcp 4.5    ویرة في العراق للفترةѧѧѧѧلمحطة الص

 2100-1951الممتدة بین 

 

 ) موقع محطة الصیرة في العراق.1.3ل (كالش
 

:ةالبیانات المتاح  

 Long = 44.770541˚E     Lat= 33.25148˚Nثیات المحطة إجدا .1

كѧѧل ملف  NetCDF" الѧѧذي یحتوي ملفѧѧات  ”pr-CNRM-CM5_rcp45_50kmالمجلѧѧد  .2

 الیومیة لسنة كاملة. التساقطاتیحتوي بیانات 

 :NetCDF Models.tbxوالموجود تحت الأداة   Model_prه باسم النموذج الذي تم بناؤ -3
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 Editالنقر علیھ بالیمین ثم اختیار ب Model-Prنفتح النموذج 

 

 .ArcCatalogمن واجھة  بالتساقطات) فتح النموذج الخاص 2.3الشكل (
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 : Iterate Filesضمن النموذج نقرة مزدوجة على أیقونة  

 

 .Model_prضمن نافذة  Iterate Files) 3.3الشكل (
 

 :Iterate Filesمن نافذة 

خلال  تسѧѧѧѧѧاقطاتلل NetCDFالملف الذي یحتوي ملفات مكان  Folderنحدد من حقل  .1

-pr-CNRM“وھѧѧѧو مѧѧѧتѧѧѧواجѧѧѧѧد ضѧѧѧѧѧѧѧѧѧمѧѧѧن الѧѧѧمѧѧѧجѧѧѧلѧѧѧѧد  2100 – 1951الѧѧѧفѧѧѧتѧѧѧرة 

CM5_rcp45_50km” 

 Okثم ننقر  .2
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 .Iterate Filesضمن نافذة الیومیة  تاالتساقطیحوي بیانات ) تحدید المجلد الذي 4.3الشكل (
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 : Make NetCDF Table Viewن النموذج نقرة مزدوجة على أیقونة  ضم

 

 

 

 

 

 

 

 .Model_prضمن نافذة Make NetCDF Table Viewاستدعاء الأداة  )5.3الشكل (
 

  Make NetCDF Table Viewافذة من ن

 pr طاتقالتسامن القائمة المنسدلة وھو  متحولنختار ال .1

  Row Dimensions = Timeنختار من القائمة المنسدلة  .2

  nlat= 91و   nlon = 162الصویرة ندخل قیم إحداثیات موقع  .3

 okننقر  .4

 

 

 

 



69 
 

 

 Make NetCDF Table View إدخال المعلومات اللازمة ضمن نافذة )6.3الشكل (
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 :Table to Table ضمن النموذج نقرة مزدوجة على أیقونة

 

 ..Model_prضمن نافذة  Table to Tableدعاء الأداة است )7.3لشكل (ا
 

 

 ضمن نافذة 

ف الذي سѧѧѧیتم جمع الجداول الناتجة لكل سѧѧѧنة من السѧѧѧنوات داخلھ ،ولیكن ملف نحدد المل .1

 Suwayrah_pr_cnrm45_1951_2100باسم 

   Suwayrah %n%.dbfغة یدد أسماء الجداول الناتجة بالصنح .2
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 . Table to Tableإدخال البیانات اللازمة ضمن نافذة  )8.3لشكل (ا
 

 الجداول الخاصة بكل سنة من السنوات نشغل النموذج بشكل جزئي من أجل تولید

 
 .Model_prتشغیل مرحلي للنموذج  )9.3الشكل (
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  Completedإشارة  عالنافذة معند انتھاء الشغیل تظھر 

 

 ..Model_prلتشغیل المرحلي للنموذج انتھاء ا )10.3الشكل (
 

سѧѧنة  150ملف ل  450فنجد فیھ    Suwayrah_pr_cnrm45_1951_2100نفتح المجلد 
 (لكل سنة ثلاثة ملفات) .

 

 جدول بیانات مطریة یومیة.150استعراض المجلد الناتج والذي یحوي  )11.3الشكل (
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الیومیة لأول سѧѧѧنة في الفترة المدروسѧѧѧة  تالتسѧѧѧاقطاأول ثلاثة ملفات والتي تمثل جدول  خقوم بنسѧѧѧن
 Suwayrah0 – Copy،وتأخذ الملفات المنسوخة بشكل تلقائي الاسم  1951وھي سنة 

 
 نسخ أول جدول في المجلد. )12.3الشكل (

 
 الجدول المنسسوخ )13.3الشكل (
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 : سنة ،ضمن جدول واحد 150جدول تمثل  150جمیع تن أجل م Appendنقرة مزدوجة على 

 

 ..Model_prضمن نافذة  Appendاستدعاء الأداة  )14.3الشكل (
 

 :  Appendضمن نافذة 

نحدد الجدول الھدف الذي سѧѧѧѧѧѧѧیتم ضѧѧѧѧѧѧѧم جداول كل :  Target  Datasetمن أجل  .1
 )Suwayrah0 – Copyالسنوات إلیھ (

 Okننقر  .2

 

 . Appendنافذة البیانات اللازمة ضمن إدخال  )15.3لشكل (ا
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لذي یضѧѧѧѧѧѧѧم قیم  Table to Excelنقرة مزدوجة على أیقونة  ناتج ا جدول ال جل تحویل ال من أ
 Excelإلى صیغة  2100 – 1951 الیومیة للفترة الممتدة بین التساقطات
 

 

 ..Model_pr ضمن نافذة Table to Excelاستدعاء الأداة  )16.3لشكل (ا
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 : Table to Excelمن نافذة ض

یفضѧѧѧѧل أن   ندخل مسѧѧѧѧار تخزین واسѧѧѧѧم ملف الإكسѧѧѧѧل الناتج ، Output Excel Fileمن اجل  .1

العالمي ،وسѧѧѧیناریو  المناخونموذج  یتضѧѧѧمن اسѧѧѧم الملف كل من اسѧѧѧم المنطقة، والمتحول المناخي

 ھا البیانات.یالانبعاثات الغازیة، و كذلك الفترة الزمنیة التي تغط

  Okننقر  .2

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 . Table to Excelإدخال البیانات اللازمة ضمن نافذة  )17.3الشكل (
 

Suwayrah_pr_cnrm45_1951_2100.xls  
 اسم المنطقة 

 متحولال
المناخي 
 التساقطات

 المناخنموذج 
 العالمي

سیناریو الانبعاثات 
عاثات الغازیة: الانب

4.5المتوسطة   

 الفترة الزمنیة للبیانات
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 بأكملھ ثم قم بتشغیلھ.  نموذجاحفظ ال

 ال

 

 

 

 

 

 

 

 

 . Model_prالنموذج  حفظ  )18.3الشكل (
 

 سیكون المخرج عبارة عن جدول بصیغة اكسل .

 ھائي لتشغیل النموذج.ن) المخرج ال19.3الشكل (
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الیومیѧѧة  (مم/یوم) المѧѧأخوذة من كѧѧل ملف  التسѧѧѧѧѧѧѧѧاقطѧѧاتلى قیم یحتوي جѧѧدول الإكسѧѧѧѧѧѧѧѧل ع

NetCDF في الموقع المطلوب 

 

 الناتج.الیومیة  التساقطات) استعراض ملف بیانات 20.3لشكل (ا
 

فلابد من  Suwayrah0 – Copy جدول إلى جدول أسѧѧاسѧѧي  150بما أنھ تم نسѧѧخ ملاحظة ھامة: 
، لذلك سѧѧѧѧنجد  1951الیومیة لسѧѧѧѧنة  التسѧѧѧѧاقطاتھذا الجدول كان یحتوي بالأصѧѧѧѧل قیم  الانتباه إلى أن

للفترة الممتدة  ف الاكسل لذلك لابد من حذف البیانات المكررة (البیاناتبیانات ھذه السنة مكررة في مل
 .1951دول نسخة واحدة للسنة ج) فیتبقى لدینا في ال31/12/1951و  1/1/1951بین 
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 ملفیومیة من   Rasterشریحة 365استنتاج حول  الرابعالتمرین العملي 
NetCDF بصیغة كملفاّت مستقلة  وتصدیرھا ،واحد)*.tif (. 

حسب نموذج  2002عام لل التساقطاتلقیم مستقلة یومیة  Rasterشریحة 356المطلوب استنتاج 

CNRM-CM5 و الانبعاثات المتوسطة یلسینارrcp 4.5 ملفات  ،انطلاقا منNetCDF  . 

 البیانات المتاحة:

 ) الذي یتضمن:ExtractMultipleTimeSlicesمجلد ( 

و اسѧѧѧѧѧѧѧمھѧا  NetCDFالشѧѧѧѧѧѧѧرائح الزمنیѧة من ملف  فصѧѧѧѧѧѧѧѧلالسѧѧѧѧѧѧѧكریبѧت( الأداة) الخѧاصѧѧѧѧѧѧѧѧة ب -1
:NetCDF_Time_Slice_export . 

 واحد. NetCDFملففي  2002طریة یومیة للعام مبیانات ھطولات  -2
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ونلاحظ محتویات المجلد    ArcCatalog ضѧѧمن واجھة نسѧѧتعرض 
 كیف یظھر السكریبت الخاص باستخراج الشرائح الزمنیة.

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 رائح.الخاص بفصل الش NetCDF_time_Slice_export) السكریبت 1.4لشكل (ا
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 ArcMapضمن واجھة  raster شریحةك NetCDF ملف عرض

 Make Netcdf Rasterمزدوجة على أداة  نقرة  Arc Toolboxصѧѧѧندوق الأدوات من  .1

Layer. 

الیومیة لعام  تسѧѧѧѧѧاقطاتلل NetCDFنحدد مسѧѧѧѧѧار ملف :   Input NetCDF Fileمن أجل  .2

2002  

 ).Prا المثال ذفي ھ التساقطاتدروس( مالمناخي ال متحولنحدد ال:  Variableمن أجل  .3

  Okننقر  .4

 .Make Netcdf Raster Layer الأداة  نافذة )2.4الشكل (
 

، ستظھر  nlatو  nlonھي  Y-Dimensionو  X-Dimensionأن الإحداثیات ملاحظة: بما 

 الشریحة ضمن نظام الإحداثیات الخاص ببیانات ریكار.
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التي تغطي  Pr_Layerباسѧѧѧم  وھي شѧѧѧریحة مؤقتة 2002للعام  التسѧѧѧاقطاتتظھر لدینا شѧѧѧریحة 
 في الشكل: النطاق العربي كما

 

 
 

 .2002الیومیة للعام  التساقطاتثل التي تم Raster) شریحة 3.4الشكل (
 

 :Pr_Layer الراستر شریحةفي خصائص  Band Dimensionتغییر 

 .propertiesنضغط بالزر الیمین على الشریحة ونختار  .1
 .time نختار من القائمة المنسدلة:  Band Dimension من أجل  .2
 Okننقر  .3

 

 
 كبعد ثالث. Time) تحدید الزمن 4.4الشكل (
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 :شریحة  365إلى  2002الیومیة لعام  التساقطاتلفصل شریحة  ریبتتنفیذ السك
 
 
 . NetCDF_time_slice_exportنفتح سكریبت Arc Catalogمن واجھة . 1

المراد اسѧѧѧتخراج الشѧѧѧرائح  NetCDF شѧѧѧریحةنحدد  NetCDF_time_slice_exportذة فضѧѧѧمن نا. 2

 الزمنیة منھا عبر الضغط على القائمة المنسدلة.

ل أن نقوم بإنشѧѧѧѧاء نختار المجلد الذي سѧѧѧѧیتم تخزین المخرجات فیھ . : Output_Folderل من أج. 3 ّѧѧѧѧیفض

 العام المقصود. ى" مثلاَ لیدل عل2002مجلد جدید للمخرجات ونسمیھ باسم "

4 .Ok 

 
 ئح.االسكریبت الخاص بفصل الشر ) تنفیذ5.4الشكل (
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 365على شѧѧѧѧكل شѧѧѧѧرائح عددھا جات لاسѧѧѧѧتعراض المخر" 2002مجلد "نفتح ال   Catalogضѧѧѧѧمن 
 .tifشریحة لاحقتھا 

 
 )..tifشریحة بصیغة ( 365) استعرض مخرجات تنفیذ الكریبت وھي 6.4الشكل (

 
شرائح المستخسأیجب ملاحظة أن  ) تدل على رقم الیوم ..…Band_1,Band_2,Band_3(  رجةماء ال

خ الѧѧѧѧدقیق لھѧѧѧѧا من خلال الرابط: في السѧѧѧѧѧѧѧنѧѧѧѧة المیلادیѧѧѧѧة والتي من الممكن الاسѧѧѧѧѧѧѧتѧѧѧѧدلال على التѧѧѧѧاری
tmlhr.https://nsidc.org/data/tools/doy_calenda  

 
. یجب الانتباه للفرق ایضѧѧѧѧا بین السѧѧѧѧنة 2002نیسѧѧѧѧان  10قابل للتاریخ : ھو الم Band_100 مثلا 

 الموقع). الكبیسة والعادیة (موضّح في نفس

. 
 .جدول بأرقم أیام السنة العادیة ) 7.4الشكل (

 

https://nsidc.org/data/tools/doy_calendar.html
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 المناخیة  RICCARحول اقتطاع بیانات  خامسالتمرین العملي ال

 على منطقة اھتمام معینة 
 

الخاصѧѧѧѧѧѧѧة بدرجات  لاقتطاع البیانات المناخیة  Model Builder میم نموذج تصѧѧѧѧѧѧѧلوب : المط
لسѧѧیناریو  CNRM-CM5العالمي  المناخب نموذج بحسѧѧ 2100 – 1951 فترةلالیومیة ل الحرارة

ربیة، وذلك إنطلاقاً من علمنطقة اھتمام تغطي جمھوریة مصѧѧѧѧѧѧر ال rcp 4.5الانبعاثات المتوسѧѧѧѧѧѧطة 
 .NetCDF اتملف

 تاحةالبیانات الم

 ”Input“موجودة ضمن المجلد  2100 – 1951بیانات الحرارة الیومیة للفترة 
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 Standardمن شریط الأدوات    Model Builder فتح نافذةا

 

 .Model Builderفتح نافذة ) 1.5الشكل (
 

 ModelBuilderواجھة  إلى Make NetCDF Raster Layerدأ بسحب أداة با

 

 .Model Builderإلى نافذة  Make NetCDF Raster Layerخال الأداة إد) 2.5الشكل (
 



87 
 

  Insert  <  Iterators < Filesاختر :  Insertمن قائمة 

 

 .Model Builderافذة نإلى  Iterate Filesإدخال الأداة ) 3.5الشكل (
 

یار ملفات باخت نموذجلإلزام ال nc.،ثم أضѧѧѧѧف  Renameواختر  Fileأیقونة  انقر بالیمین على 

NetCDF  فقط.  

 
 Iterate Filesحصرا للأداة  NetCDFتحدید ملفات من نوع ) 4.5الشكل (
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واحد، في مجلد  NetCDFلابد من حفظ كل ملفات  نموذجأي خلل في عمل ال : لتجنبملاحظة

  وبدون أي رموز          د بما فیھ أسѧѧѧѧѧماء المجلدات الأصѧѧѧѧѧل بأقصѧѧѧѧѧر مایمكنأن یكون اسѧѧѧѧѧم المجل على

ماذج  ، .) -( فة أو ن ناخ المختل بارامترات الم ناخوتجنب خلط  ناریوھات  GCMs الم أو السѧѧѧѧѧѧѧی

RCPs. 

                                                                 Iterateلѧѧѧѧѧمѧѧѧѧѧجѧѧѧѧѧلѧѧѧѧѧد الѧѧѧѧѧذي سѧѧѧѧѧѧѧѧѧѧѧیѧѧѧѧѧتѧѧѧѧѧم داخѧѧѧѧѧلѧѧѧѧѧھ عѧѧѧѧѧمѧѧѧѧѧلѧѧѧѧѧیѧѧѧѧѧة مѧѧѧѧѧن أجѧѧѧѧѧل تѧѧѧѧѧحѧѧѧѧѧدیѧѧѧѧѧد ا

  Insert < Create Variable   Folder>اختر 

 

 

 

 

 

 

 

 

 

 .Iterate Filesالمجلد الذي سیتم ضمنھ  جھیزت) 5.5شكل (ال
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من أجѧѧѧل الاختیѧѧѧار المتكرر من  Iterate Filesو  Folderبین    connectاختر ثم 

Folder .  

 

 .Iterate Filesربط المجلد مع الأداة ) 6.5كل (شال
 

  NetCDF فѧѧات المجلѧѧد الخѧѧاص الѧѧذي تم حفظ مل واختر  Folderنقرة مزدوجѧѧة على أیقونѧѧة 

 ”Input“   داخلھ

 

  Iterate Filesلأداة   NetCDFإدخال المجلد الذي یحري ملفات ) 7.5الشكل (
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طوة بناء إلى ملونة ما یدل على أن خ model builderة ھندئذ سѧѧѧѧѧѧѧتتحول الأیقونات في واجع

 ونةوأیق Make NetCDF Raster Layerالنموذج الحالیة تمت بشѧѧكل صѧѧحیح. بینما أیقونة 
Output Raster Layer  الوان لأنھا لم تكتمل بعد. تبقى بدون 

 

 أصبحت جاھزة. Iterate Files جزئیة النموذج المتعلقة بالأداة) 8.5الشكل (
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نقرة بالیمین على ، 2100 -1951السѧѧѧѧѧѧѧنویة للفترة  بعد تحدید المجلد الذي یحوي ملفات الحرارة

 داخل المجلد. NetCDFملف  150جل قراءة من أ Runثم اختر  Iterate Filesأیقونة 

 

  Iterate Filesتشغیل الأداة ) 9.5الشكل (
 :Make NetCDF Raster Layerقرة مزدوجة على أیقونة ن

 

  Make NetCDF Raster Layerى أیقونة نقرة مزدوجة عل) 10.5الشكل ( 
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 نتبع الخطوات التالیة: Make NetCDF Raster Layerمن نافذة 

 موجود ضمن المجلد. NetCDFنختار أول ملف : Input netCDF Fileجل من أ .1

 Make NetCDF Raster Layer  ضمن نافذة NetCDFإدخال أول ملف ) 11.5الشكل (

 

 tasنختار المتحول المناخي المطلوب من القائمة المنسدلة وھو  : Variableمن أجل  .2

 Make NetCDF Raster Layer إدخال المتحول المناخي ضمن نافذة) 12.5الشكل (
 

 lon: نختار من القائمة المنسدلة  X Dimensionمن أجل   .3

 Make NetCDF Raster Layer افذةنضمن  xإدخال البعد ) 13.5الشكل (
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 lat:نختار من القائمة المنسدلة  Y Dimensionمن أجل  .4

 

 Make NetCDF Raster Layer ضمن نافذة yإدخال البعد ) 14.5الشكل (
 

 : نترك اسم الشریحة الناتجة بدون تغییر   Output Raster Layerمن أجل  .5

 . Timeالمنسدلة  ةائمالق: نختار من  Band Dimensionمن أجل  .6

 

 Make NetCDF Raster Layer ضمن نافذة Timeد إدخال البع) 15.5الشكل (
 

 Okننقر  .7
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أصبحت ملونة  Make NetCDF Raster Layerب وبذلك نلاحظ ان جزئیة النموذج المتعلقة 

مما یدل على انھا جاھزة للتشغیل.

 

 زةجاھ Make NetCDF Raster Layer الجزئیة) 16.5الشكل (

بد من اخو بل التشѧѧѧѧѧѧѧغیل لا   Makeة داوالأ File.ncللربط بین   connectار الأداة یتلكن ق
NetCDF Raster Layer  

 

 Make NetCDF Raster Layerمع تعلیمة  NetCDFربط المجلد الذي یحوي ملفات ) 17.5الشكل (
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موجودة  File.ncلنتأكد أن  Make NetCDF Raster Layerثم ننقر مرة أخرى على أیقونة 
 . Input NetCDF Fileضمن الحقل 

 

 Make NetCDF Raster Layer معلومات نافذةالتحقق من ) 18.5الشكل (
 

 Make NetCDF Rasterالمدخلة إلى نافذة ) یوضح الشكل النھائي للمعلومات  .519(والشكل 
Layer . 

 

 Make NetCDF Raster Layer نافذة المعلومات المدخلة إلى) 19.5الشكل (
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سѧѧѧѧѧوف تتداخل مع تلك في الشѧѧѧѧѧكل   NetCDFالبیضѧѧѧѧѧوي الأزرق على ان ملفات  یدل الشѧѧѧѧѧكل

بیضѧوي الأزرق ،بكل الأحوال یمكن الاسѧتغناء عن الملف ال .File.ncالبیضѧوي الأخضѧر للملف 

 .  Deleteبعمل 

 

 تم إدخالھ. NetCDFملف  حذف الشكل البیضوي الأزرق الذي یحوي أول) 20.5الشكل (

 Runثم   Validate Entire Modelنعمل 

  للتأكد من أن كل شيء یسیر على مایرام. 

 

 تشغیل مرحلي للنموذج) 21.5الشكل (
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التي نتجت من ملفات  Rasters رائح النقطیةالشѧѧѧѧمن أجل قص  Clipالخطوة الأخیرة: إضѧѧѧѧافة 
NetCDF . 

 مسارالموجودة في ال Clipالأداة   Model Builderأضف إلى واجھة 
  Tools < Raster < Raster Processing . 

 

 إلى نافذة النموذج Clipإدخال الأداة ) 22.5الشكل (
  Clipلتعلیمة ) إلى اtas_layerالبیضوي الأخضر (یبدأ من الشكل    Connectثم اختر 

 

 Clip و الأداة Make NetCDF Raster Layerة الربط بین الشرائح الناتجة عن أدا) 23.5ل (كالش
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 :  Clipنقرة مزدوجة على أیقونة 

 

 Clipفتح نافذة الأداة ) 24.5الشكل (
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 :Clipنافذة  ضمن

حة  Output Extentمن أجل  ثل منط Shapefile: اختر شѧѧѧѧѧѧѧری مامالتي تم  يوھ قة الاھت

Egypt_Box   

خصیصا لحفظ  ي تم إنشاؤهذال outputالمجلد : اختر Output Raster Datasetمن أجل 

) ھذه الطریقة %Egypt_%Nameوأعط للملف الناتج اسѧѧما (  الشѧѧرائح التي سѧѧیتم اقتطاعھا.

 NetCDFفي التسѧѧѧѧمیة سѧѧѧѧوف تسѧѧѧѧمح بإعطاء الملفات الناتجة أسѧѧѧѧماء متوافقة مع أسѧѧѧѧماء ملفات 

ف یھ  فات إ(وعل ماء مل ѧѧѧѧѧѧѧن أسNetCDF یة في المجلد یج حرفا مثلا  13ب ألا تتجاوز الأصѧѧѧѧѧѧѧل

tas_2000  ،tas_2001 .. المناخي والتاریخ متحول.الخ، بحیث یبین الاسم 

 Clipلمعلومات اللازمة إلى نافذة إدخال ا) 25.5الشكل (
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مین على یاضѧѧѧѧѧѧѧغط بالزر ال ArcMapمن أجل إظھار مخرجات النموذج مباشѧѧѧѧѧѧѧرة على واجھة 

 ) Add to display) وأختر (%Egypt%Nameالمُخرج(

 
 إلى قائمة الإظھار.Clipإضافة ناتج العملیة ) 26.5الشكل (

 

  Clip_Models.tbxوذلك ضمن أداة  Clipبعد الانتھاء من تصمیمھ باسم  نموذجنحفظ ال

 

 حفظ النموذج الذي تم تصمیمھ.) 27.5الشكل (
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 Run> Run Entire Modelمن خلال  موذجنل الیشغت

 
 تشغیل النموذج) 28.5الشكل (

 

  NetCDFالباندات، حیث یمثل كلّ باند ملف ة متعدد Rasterشریحة  150 المخرج عبارةٌ عن

   (مصر)ومقتطع على منطقة الدراسة 

 

 الشرائح الناتجة عن الاقتطاع) 29.5الشكل (
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المخرج، وإختیار  raster شѧѧѧѧѧѧریحةزر الأیمن على رض خصѧѧѧѧѧѧائص كل نطاق بالنقر بالعیمكن 

 "خصائص" . 

 

 ناتجة عن النموذج.النطاقات، الخصائص الشرائح المتعددة ) 30.5الشكل (
 

  ArcCatalogما یمكن إستعراض خصائص كل باند زمني عن طریق 

 

 
 ن كل شریحة ناتجة.مالیومیة ض بانداتال) 31.5الشكل (
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 RICCARلبیانات ) Resample(  رفع الدقة المكانیةول ح سادسلعملي الالتمرین ا
 المناخیة .

 

العالمي  المناخبحسѧѧѧѧѧѧѧب نموذج  2019الیومیة لعام  تالتسѧѧѧѧѧѧѧاقطالبیانات المطلوب رفع الدقة المكانیة 
CNRM-CM5  سیناریو الانبعاثات المتوسطة كم ،وذلك  25*25كم إلى  50*50 ، من rcp 4.5ل

 . مصر العربیةتغطي جمھوریة  اھتماممنطقة ل

 

 
 

 التمرین العملي. ق) منطقة تطبی1.6الشكل (
 لبیانات المتاحة:ا

 الموجود ضمن الملحقات. NetCDF_time_slice_exportسكریبت  .1
 " والذي یحوي:Resample_Excerciseمجلد " .2

x  منطقة الاھتمامحدود. 
x  ملفNetCDF 2019عام الیومیة ل لتساقطاتیحوي بیانات ا. 

 في الملحقات. Resample لیمة لتنفیذ تع نموذج .3

 )Resample_Exercise(البیانات موجودة ضمن مجلد باسم 

 



104 
 

 :ArcMapئة إلى بی NetCDFاستیراد ملف 

 ArcToolbpx :Multidimension tools<Make NetCDFمن صѧѧѧѧѧѧѧنѧѧѧѧدوق الأدوات .1
Raster Layer. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 . Make NetCDF Raster Layer) الأداة 2.6( الشكل
 
الموجود ضѧѧѧѧѧѧѧمن مجلѧد  NetCDFنختѧѧار مسѧѧѧѧѧѧѧѧار ملف :  Input NetCDF Fileمن أجѧل  .2

Resample_Exercise 
 
 ).Pr: التساقطاتالمناخي المدروس ( معدل  متحولندخل ال: Variableمن أجل  .3

 
 .lonنختار : X Dimensionمن أجل  .4

 
 latنختار : Y Dimensionمن أجل  .5

 
 Okننقر  .6
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 . Make NetCDF Raster Layerلومات اللازمة ضمن نافذة  ) إدخال المع3.6الشكل (
 

 شریحة مؤقتة.وھي  ،ArcMapضمن واجھة  Pr_Layerباسم    Raster شریحةتظھر 

 

 
 .  NetCDFمن ملف  قتة المستنتجةؤالم Raster) شریحة 4.6الشكل (
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 pr_Layerالشریحة في خصائص   Band Dimensionتغییر 

 .Propertiesونختار الشریحة النقطیة  لفأرة علىننقر بالزر الیمین ل -1

 Timeونختار  Band Dimensionننقر على القائمة المنسدلة من  NetCDFضمن نافذة  -2

3- Ok 

 
 .لمؤقتةا Rasterلشریحة كبعد ثالث  Timeحدید الزمن ت)5.6الشكل (

 
 

 ل التعامل معھامثلاً لكي یسھ tif.بصیغة  التساقطاتتصدیر الشرائح الیومیة لمعدلات 

 لھذه الغایة( موجود في الملحقات) NetCDF_time_slice_exportنستخدم سكریبت 

 تبنفتح السكرینقرة مزدوجة و  ArcCatalogمن واجھة  -1

2- Input_NetCDF_Layer  : تر المؤقتة  لذي ھو عبارة عنالمُدخل انختارѧѧѧѧѧریحة الراسѧѧѧѧѧالش

Pr_Layer المحتویات قائمةفي  الموجودة 

3- Output Folder :ولیكن " نحدد مجلد الإخراجDaily_pr" 
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 Ok ننقر  -4

 
 

 .لشرائحتشغیل السكریبت الخاص بفصل ا) 6.6الشكل (
 

 
 

 السكریبت.قطة اثناء تشغیل ل) 7.6الشكل (
 
 

 معالج الحاسب. إمكانیات ، وھذا یعتمد علىأن تستغرق ھذه العملیة وقتا  ملاحظة : یمكن
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 كل ملف یعبر عن یوم في السنة. tif.ملف بلاحقة  365عد الإنتھاء من العملیة ینتج لدینا ب
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 .بعد فصلھا 2019الیومیة للعام  تساقطاتال Rastersشرائح ) 8.6ل (الشك
 

 

 من خلال تنفیذ خطوتین الأولى، التسѧѧѧѧѧاقطاتللشѧѧѧѧѧرائح الیومیة لمعدل  Resampleرفع الدقة المكانیة 
 :Resampleعملیة  والثانیة، منطقة الاھتمامقص الشرائح المُستخرجة على حدود 
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 نموذجعمل نشѧѧریحة) ولتوفیر الوقت والجھد  365تعددة (افتراضѧѧیاً ولكي نقوم بالعملیة على شѧѧرائح م

 (موجود مع الملحقات) یتضمن العملیتین معاً، model builderبسیط باستخدام 
 

  ، نقف على ایقونة النموذج   ArcCatalogضمن واجھة 
 

 .وذجنمنافذة ال تفتحل Editونختار  Resample نموذجننقر بالزر الیمین للفأرة على ال .1

 

 .Resampleفتح النموذج  )9.6الشكل (
الѧѧذي یحوي ملفѧѧات "  daily_pr"لإختیѧѧار المجلѧѧد  Outputیقونѧѧة جѧѧة على الأننقر نقرة مزدو .2

 tif.سابقة والتي لاحقتھا المستخرجة في العملیة ال الراستر

 
 ) إدخال مجلد الشرائح الیومیة لیعمل النموذج علیھا.10.6الشكل (
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 سѧѧطرمن والمدخل الوحید سѧѧیكون ضExtract by mask ،ѧѧة نأیقو ىنقرة مُزدوجة عل .3
Input raster or feature mask data  حیث ندخلArea_of_Interest.shp 

 .Ok، ثم ننقر   Resample_ Exerciseالموجود ضمن مجلد 
 

 
 Extract by mask) تنفیذ التعلیمة 11.6لشكل (ا

 

  Resample أیقونة نقرة مزدوجة على 

 

 صمن النموذج. Resample) استدعاء الأداة 12.6شكل (ال
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 Resampleفتفتح نافذة تعلیمة 

 
 

 . Resample) إدخال المعلومات اللازمة اضمن لأداة 13.6الشكل (
 

 Resampleیمة نافذة تعل 

، وذلك ندخل مسار المجلد الذي سیحتوي المخرجات :  Output Raster Dataset من أجل  .1
 فتراضي. ا المسار ثم عمل لصق لھ مكان المسار الاخ ھذسمن خلال ن

 
 . Resample) إدخال مسار المجلد الذي سیحتوي نتائج عمل الأداة 14.6لشكل (ا
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ثم نكتب  %Name%ثم نكتب اسѧѧم الملفات الناتجة على الشѧѧكل ، )\بعد اسѧѧم المسѧѧار مباشѧѧرة نكتب (
للاحقѧѧѧѧة   كون الاسѧѧѧѧѧѧѧѧم  CR.tif_ا ی ما، وبѧѧѧѧذلѧѧѧѧك  ل ئي ا نھѧѧѧѧا حقѧѧѧѧل "ل ل من ھѧѧѧѧذا ا ѧѧѧѧѧѧѧѧتوب ض  ك

D:\VA_Training\TrainingMannual\Resample_Exercise\output\%Na
me%_CR.tif   

 
 . Resample) تحدید أسماء الملفات الناتجة عن الأداة 15.6الشكل (

 
درجة  0.22الجدیدة وھي كما أسѧѧѧѧѧلفنا  المكانیة الدقة،نحدد قیمة  Output Cell Size من أجل .2

 كم مربع. 25تعادل  يوالت

 
 الدقة المكانیة الجدیدة .) تحدید 16.6الشكل (

 

نختار  Resampleتتوفر أربع خیارات لطرق تطبیق  Resampling Technique ن أجلم .3
 . CUBICمنھا طریقة 

 
 .Resample) اختیار الطریقة الإحصائیة لتنفیذ 17.6كل (الش

 

 Okننقر  .4
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 .Resample نافذةاللازمة إلى  تإدخال المعلوما) 18.6الشكل (

 
 

 وذج بعد أن أصبح جاھزاتشغیل النم

 
 

 . Resample) تشغیل النموذج 19.6الشكل (
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 مخرجات النموذج :  
كم مربع، تبدو  25وذات دقة مكانیة تبلغ ھتمام منطقة الاشریحة مُقتطعة على حدود  365ھو 

 كما في الشكل:
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 Resampleت الناتجة عن الأداةد أسماء الملفای) تحد20.6الشكل (

 
 

 
 
 
 
 
 
 
 
 
 

 
 على منطقة اھتمام. Resample) أمثلة عن نتائج عمل 21.6الشكل (

 



115 
 

لشھریة او السنویة ...الخ كیفیة استنتاج المعدلات احول بع ساالعملي التمرین ال
 للبیانات المناخیة

 

 المناخحسѧѧѧѧب نموذج  2035آذار لعام  رشѧѧѧѧریحة متوسѧѧѧѧط درجات الحرارة لشѧѧѧѧھ المطلوب اسѧѧѧѧتنتاج
سیناریو الانبعاثات المتوسطة  CNRM-CM5العالمي  للمجال العربي، وذلك إنطلاقاً من  rcp 4.5ل

 tif.البیانات الیومیة شھر آذار والمتمثلة بلمفات 

 البیانات المُتاحة:

 : ensample_exerciseمجلد ضمن 

ضѧѧمن  .tif  بصѧѧیغة 2035للعام رارة الیومیة الیومیة لشѧѧھر آذار حلدرجات ال Rastersشѧѧرائح  .1
كما في  Time Sliceوھي أصلا شرائح الحصول علیھا من خلال عمل , mar_dailyمجلدا ال

 التمرین الثالث

 

عدید لسѧѧنة المطلوبة كبیسѧѧة أم عادیة ، ویمكن أن یتم ذلك من خلال االخطوة الأولى ھي التأكد من أن ال
 years.php-365.de/leap-https://kalenderمن المواقع نذكر ھنا مثالا عنھا 

ة ، وبѧѧѧѧالѧѧѧتѧѧѧѧالѧѧѧي ومѧѧѧن الѧѧѧمѧѧѧوقѧѧѧع ھѧѧѧي سѧѧѧѧѧѧѧѧѧنѧѧѧѧة عѧѧѧѧادیѧѧѧѧ 2035حѧѧѧیѧѧѧѧث تѧѧѧم الѧѧѧتѧѧѧѧأكѧѧѧѧد ان سѧѧѧѧѧѧѧѧѧنѧѧѧѧة 
mlps://nsidc.org/data/tools/doy_calendar.httht 

  Band60إلى  Band 30 المجال بین تحدید أرقام الباندات التي تغطي شھر آذار وھي تم

 

 

 

 

 

 

 

 

https://kalender-365.de/leap-years.php
https://nsidc.org/data/tools/doy_calendar.html
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أدوات التحلیل  من صѧѧѧѧѧندوق الأدوات الموجودة على الموجودة تحت Cell Statisticsنفتح أداة  .1
جموع أو وق الأدوات، حیث یمكننا من خلالھا حساب المد" في صنSpatial Analystالمكاني "

 Spatial"، وفق المسѧѧѧѧѧار: rasterوغیره من البیانات الإحصѧѧѧѧѧائیة لعددٍ من ملفات "المتوسѧѧѧѧѧط 
Analyst Tools>Local>Cell Statistics 

 
 .ArcToolboxجھة ضمن وا Cell Statistics) الأداة 1.7الشكل (
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  Mar_dailyنضیف الملفات من مجلد : Input Raster or Constant Values من أجل .2

 
 . شرائح الحرارة الیومیة لشھر آذار  ) إدخال2.7الشكل (

 ستظھر ضمن النافذة بالشكل التالي  Addملف وعمل  30عد اختیار ب

 .Cell Statistics نافذةالشرائح الیومیة لشھر اذار ضمن ) إضافة 3.7الشكل (
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جلѧѧѧѧد  : Output Rasterمن أجѧѧѧѧل  .3 م ل من ا ѧѧѧѧѧѧѧѧكن ض ی ل مخرج و ل خزین ا ت مكѧѧѧѧان  نحѧѧѧѧدد 

ensample_Exrcise ѧѧѧѧѧي لѧѧѧѧѧطѧѧѧѧѧعѧѧѧѧѧمٍ ونѧѧѧѧѧѧѧѧѧѧѧѧرج اسѧѧѧѧѧخѧѧѧѧѧمѧѧѧѧѧن  لѧѧѧѧѧكѧѧѧѧѧیѧѧѧѧѧة ولѧѧѧѧѧذو دلال :  
mar_tasmean_cnrm45_2035.tif  ط درجات الحرارة للنطاق العربيѧѧوالذي یمثل متوس

 .2035في شھر آذار من عام 

 
 دید مكان تخزین واسم شریحة المعدل الناتجة.) تح4.7الشكل (

 

لتي تمثل القیمة الإحصائیة وا MEAN المنسدلةمن القائمة  نختار :Overlay Statisticأجل  نم-4
 لمتوسط درجات الحرارة للشرائح المُختارة.

 
 .لحساب شریحة المعدل Mean)اختیار الطریقة الإحصائیة 5.7الشكل (

 

 Ignore NoData in calculationنفعلّ خیار  -5

 OKنضغط  -6
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 .Cell Statisticsنافذة الأداة  )6.7الشكل (
ѧѧѧѧѧم سѧѧѧѧѧریحة باسѧѧѧѧѧیكون المُنتج شmar_tasmean_cnrm45_2035.tif  طةѧѧѧѧѧتحمل القیم المتوس

 لدرجات الحرارة في شھر آذار.

 

 .2035) شریحة معدل درجات الحرارة لشھر آذار 7.7الشكل (
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لبیانات ) لInterpolation( حول إجراء عملیة الإستقراء ثامنالتمرین العملي ال
  Bias Correctionفي المناطق الساحلیة نتیجة المناخیة المفقودة 

العالمي  المناخبحسѧѧѧѧѧѧب نموذج  2035الحرارة المفقودة لشѧѧѧѧѧѧھر آذارعام المطلوب اسѧѧѧѧѧѧتقراء بیانات  
CNRM-CM5  طةѧѧѧѧѧѧیناریو الانبعاثات المتوسѧѧѧѧѧѧلسrcp 4.5 م تغطي جُزءاً من الخلیج لمنطقة اھتما

ً بالعر ً  من شریحة تمثل متوسط درجاي، وذلك إنطلاقا  .ت الحرارة لشھر آذار محسوبة مُسبقا

 

 ) منطقة تطبیق عملیة الاستقراء.1.8الشكل (
 البیانات المُتاحة:

 والذي یضم: Interpolation_excerciseمجلد  

x  حدود منطقة الإھتمامClip_feature.shp. 
x  ملفmar_tasmean_cnrm45_2035.tif  ات وѧѧط درجѧѧѧѧѧѧѧل متوسѧѧذي یمثѧѧال

 .2035ام الحرارة لشھر آذار ع
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 :ArcMapاستیراد الملف إلى بیئة 

  .لإضافة شریحة درجات الحرارة وشریحة الإقتطاع نضغط 

 
 .2035) شریحة معدل درجات الحرارة لشھر آذار 8.1الشكل (

 

 ة.المفقودالحراریة  بیاناتھاقراء استتي سیتم لالساحلیة ا المناطقتكبیر على 

 
 ) المناطق الساحلیة التي سیتم استقراء بیاناتھا المفقودة2.8الشكل (
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 وإضافة شریط الأدوات الخاص بھ. Geostatistical Analystیل إمتداد تفع
 Extensionsنختار  Customizeمن قائمة  .1
  Geostatistical Analystنقوم بتفعیل خیار  .2
3. Close 

 
 .Extensionضمن نافذة  Geostatistical Analystل الامتداد ) تفعی3.8ل (الشك

 

 Geostatistical Analystإظھار شریط أدوات 
 نضغط بالزر الیمین للفأرة في الأعلى. -1
 .Geostatistical Analystنختار إظھار شریط الأدوات  -2
 الشكل أعلاه. یبدو الشریط كما في -3

 
 .ArcMapضمن واجھة  Geostatistical Analystوات یط الأد) إظھار شر4.8الشكل (
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 :interpolationاجراء عملیة 

 Geostatisticalفي شریط الأدوات ونختار  Geostatistical Analystنضغط على قائمة  -1
Wizard 

 IDW: Inverse Distance Wightingوھي في المثال  Interpolationنختار طریقة الـ  -2

 یحة الممثلة لمتوسط درجات الحرارة لشھر آذاررنختار الش -3

4- Finish. 

 
 .Interpolation) خطوات إجراء عملیة 5.8الشكل (
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 تظھر الشریحة المُستقرأة كما في الشكل:

 
 ) الشریحة الناتجة عن الاستقراء.6.8الشكل (

ینبغي تحویل منتج  ذاكرة الحاسѧѧѧѧѧѧѧب ولا یمكن العمل علیھا، لذلك ىھي شѧѧѧѧѧѧѧریحة مؤقتة محفوظة علو
 ." GA Layer to Grid" باستخدام أداة " raster" إلى صیغة "interpolationالإستقراء "

 Tableالناتجة في  IDWإضѧѧغط بالزر الیمین على شѧѧریحة " GA Layer to Gridأداة "  لتفعیل
of Contents ثم ،Data>Export to Raster. 

 
 .Rasterى لناتجة إل) تصدیر الشریحة ا7.8الشكل (
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 كما في الشكل: فتظھر GA Layer to Gridالأداة  Export to Rasterحیث تمثل 

  IDWنختار شریحة  .1
 Ga_Mar_2035.tifمجلد الإخراج، ونسمي الشریحة نختار  .2

3. OK 

 . GA Layer to Gridة ذ) إدخال المعلومات اللازمة ضمن ناف8.8الشكل (
 

یحة على منطقة الإھتمام:اقتطاع الشر  
 Spatial Analystصѧѧѧѧѧѧѧѧѧѧѧѧѧنѧѧѧѧѧѧدوق الأدوات نѧѧѧѧѧѧفѧѧѧѧѧѧتѧѧѧѧѧѧح أداة الإقѧѧѧѧѧѧتѧѧѧѧѧѧطѧѧѧѧѧѧاع: مѧѧѧѧѧѧن  .1

Tools>Extraction>Extract by mask 
 . Ga_Mar_2035.tifنحدد الشریحة  : Input Rasterمن أجل  .2
 .clip featureالإقتطاع  ةنحدد شریح: Input raster or feature mask dataمن أجل  .3
الشѧѧѧѧѧѧѧریحѧѧѧة مع اللاحقѧѧѧة ولتكن  الإخراج واسѧѧѧѧѧѧѧمد نحѧѧѧدد مجلOutput raster :ѧѧѧمن أجѧѧѧل  .4

aoi_mar_2035.tif 
5. Ok 

 

 .معلى منطقة الاھتما ملیة الاقتطاع) خطوات إجراء ع9.8الشكل (
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 یظھر المخرج المُقتطع على منطقة الإھتمام كما في الشكل:

 
 .ریحة الناتجة عن الاقتطاعشال) 10.8الشكل (
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ت المناخیة خلال فترة معینة متحولاي تقدیر التغیر فحول  تاسعین العملي الالتمر
 بالمقارنة مع فترة مرجعیة .

 
 

 

-2081لفترة نھایة القرن(  تسѧѧѧѧѧѧѧѧاقطاتالمُعدل  المطلوب حسѧѧѧѧѧѧѧѧاب التغیر المتوقع في
) حسѧѧѧѧѧѧѧب 2005-1986رجعیة ( مللفترة ال التسѧѧѧѧѧѧѧاقطاتمع معدل بالمقارنة ) 2100
 rcp 4.5توسѧѧѧѧѧѧѧطة لسѧѧѧѧѧѧѧیناریو الانبعاثات الم CNRM-CM5مي العال المناخنموذج 

 للمجال العربي 

 

 البیانات المُتاحة:

 والذي یحوي: compare exerciseمجلد 

 2005-1985في الفترة المرجعیة  التساقطاتعدل یمثل م   pr_refشریحة  .1
  2100-2081نھایة القرن في الفترة المستقبلیة  التساقطاتتمثل معدل  pr_45_81-00شریحة  .2
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 ArcMapیحتین إلى واجھة الشر نقوم بإضافة 
 فتظھر كما في الشكل:

 
 نھما.التغیر بیقیمة إضافة الشریحتین اللتین سیتم حساب  )1.9الشكل (

 

 مسارلنفتح الأداة من صندوق الأدوات وفق ا .1
Spatial Analyst Tools>Map Algebra>Raster Calculator 

 
 

 .ArcMapضمن نافذة  Raster Calculator)الأداة 2.9الشكل (
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  Raster Calculatorضمن نافذة 
ھایة القرن والفترة ن التسѧѧѧѧѧѧѧاقطات في فترة انقوم بكتابة المعادلة التي تعبر عن الفرق بین معدل  .2

 لمرجعیة: ا

"pr_45_81-00"-"Pr_ref" 

" فتنزل  pr_45_81-00خلال فترة نھایة القرن " التسѧѧѧاقطاتوجة على شѧѧѧریحة معدل نقرة مزد
 الخاصة بكتابة المعادلات إلى النافذة السفلیة

 

 .raster calculator) إلى نافذة pr_45_81_100إدخال الشریحة الأولى ( )3.9الشكل (
 

) إلى -شѧѧѧѧѧѧارة الطرح () ضѧѧѧѧѧѧمن مجموعة الازرار فتنزل إ-( Subtractر زثم نقرة واحدة على 
 نافذة المعادلات.

 
 .raster calculatorإلى نافذة  عملیة الطرحإدخال  )4.9الشكل (
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" فتنزل إلى النافذة  pr_refخلال الفترة المرجعیة " التسѧѧѧѧѧѧѧاقطاتنقرة مزدوجة على شѧѧѧѧѧѧѧریحة معدل 
 اصة بكتابة المعادلاتالسفلیة الخ

 
 .raster calculator) إلى نافذة pr_ref)إدخال الشریحة الثانیة  (5.9الشكل (

 

 Pr_End-Ref: ختار مجلد الإخراج واسم المخرج بحیث یدل على المنتج، مثلاً ن .3
4. Ok 

 

 

 
 .raster calculator) نافذة 6.9الشكل (

 



131 
 

خلال فترة نھایة القرن  التساقطات تطرأ على معدلاتالتغیرات المتوقع ان تحوي الشریحة الناتجة قیم 
من المتوقع ان تتناقص على سѧѧѧѧѧѧѧواحل  التسѧѧѧѧѧѧѧاقطاتمع الفترة المرجعیة حیث یلاحظ أن قیم  بالمقارنة

 في الصومال وعمان على سبیل المثال. التساقطات بینما یتوقع زیادة في المغرب العربي مثلا

 

لقرن بالمقارنة خلال فترة نھایة ا التساقطاتر المتوقع على یعن التغ تعبر  Raster) الشریحة الناتجة 7.9الشكل (
 مع الفترة المرجعیة.
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